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UNIVERSITY	OF	MASSACHUSETTS	AMHERST	

INSTITUTE	FOR	APPLIED	LIFE	SCIENCES	

Human	Testing	Center	

	Core	Access,	Training,	Scheduling,	Pricing,	and	Billing	

	

Most	relevant	information	for	gaining	access	to	the	Cores	within	the	Human	Testing	Center	can	be	
found	on	the	Core	websites.	Access	will	only	be	given	to	users	once	all	steps	have	been	completed.		

	
a) Core	Access:	

Internal	User.	

If	you	are	a	UMass	Amherst,	UMass	system,	or	Five	College	based	researcher	who	is	doing	research	
that	would	receive	‘internal’	pricing.	The	following	steps	outline	how	you	will	gain	access	to	the	Core	
Facilities.		

i) Contact	Michael	Busa	the	Core	Facility	Director	and	discuss	your	projects	needs	and	
timelines	(mbusa@umass.edu,	413-755-0574).	

ii) If	you	are	new	to	IALS	a	MOU	and	payment	authorization	form	must	be	completed	for	each	
core	facility	you	would	like	to	use.	The	PI’s	Start	Up	paperwork	can	be	found	in	the	Forms	
tab	of	the	webpage.		

External	User	

If	you	are	an	external	user	from	an	academic	or	industry	partner,	please	contact	Michael	Busa,	the	
Core	Director,	to	discuss	your	needs	(mbusa@umass.edu,	413-577-0574).		

b) Training:	Individuals	who	would	like	to	use	any	piece	of	equipment	in	the	Human	Testing	Center	
must	complete	a	training	session	with	Core	staff	(Core	Rates	Apply).	These	trainings	serve	as	
both	a	technical	tutorial	for	equipment	use	and	an	orientation	for	users	to	the	Human	Testing	
Center.	For	users	who	already	have	expertise	in	the	use	of	a	particular	piece	of	equipment,	they	
can	request	that	they	just	demonstrate	proficiency	in	use	and	skip	the	tutorial.	Please	note	that	
even	though	a	user	may	be	proficient	in	the	technical	aspects	of	a	certain	piece	of	equipment	
that	the	integration	of	the	billing	and	data	storage	systems	in	the	IALS	cores	differs	from	
standalone	pieces	of	equipment.	Being	trained	on	these	aspects	will	ensure	that	data	is	properly	
stored	and	billing	records	are	accurate.		

As	part	of	the	training,	the	prospective	user	must	also	provide	the	Core	Staff	with	proof	
of	the	require	EHS	trainings.	All	require	trainings	are	located	at	the	beginning	of	each	
instruments	Standard	Operating	Procedure.		

	
c) Scheduling:	All	scheduling	of	equipment	time	is	to	be	done	through	the	Facilities	Online	

Management	system	(FOM).	
i) Supervisors	(i.e.	PIs)	must	have	supervisor	accounts	created	prior	to	having	their	RA’s	create	

profiles,	the	Core	Director	will	do	this	for	them	following	an	initial	email	or	phone	call	
indicating	their	intention	to	use	a	core.		

ii) All	users	must	create	their	own	FOM	account	and	link	it	to	their	supervisor.	
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(1) They	must	then	click	on	the	individual	capacity	that	they	want	to	gain	access	to,	and	
request	a	training	time	with	the	Core	Staff.		

(2) During	registration,	they	must	use	the	speedtype	that	matches	the	Payment	
Authorization	Form	that	is	submitted	as	part	of	the	PI’s	Start	Up	paperwork.	Additional	
speedtypes	can	be	added	by	users	in	the	case	when	they	work	on	multiple	projects.		
	

d) Pricing/Usage:	Pricing	for	facility	use	are	posted	on	the	Core	websites.	
i) Rates	are	set	on	an	annual	basis	and	are	subject	to	change.		
ii) Prices	are	set	in	FOM.	Charges	for	use	are	based	on	FOM	active	time	rounded	up	to	the	

next	complete	scheduling	period.		
	

e) Billing:	Billing	is	carried	out	by	the	IALS	accounting	staff.		
i) Statements	are	sent	out	to	supervisors	and	their	designated	representative.		
ii) Disputes	or	changes	in	speedtype	to	the	invoice	must	be	made	within	10	business	days,	

otherwise	the	selected	speedtype	will	be	automatically	changed.		

	



Updated:	16	October	2017	 Exercise	Intervention	&	Outcomes	Core	 1	

	
	

Manual	of	Procedures	
	

Exercise	Intervention	&	Outcomes	Core	
	

	
	

Institute	of	Applied	Life	Sciences	

Life	Science	Laboratories	S360	
240	Thatcher	Road,	

Amherst,	MA	01003	

at	the		

University	of	Massachusetts,	Amherst	

	
	

	
	
	

	
	
	



Updated:	16	October	2017	 Exercise	Intervention	&	Outcomes	Core	 2	

	
UNIVERSITY	OF	MASSACHUSETTS	AMHERST	

INSTITUTE	FOR	APPLIED	LIFE	SCIENCE	

Exercise	Intervention	and	Outcomes	Core	

Chapter	1:	ParvoMedics	TrueOne	2400	

	

1.1	Introduction:	The	TrueOne	®2400	Metabolic	Measurement	System	(ParvoMedics,	INC.,	Sandy,	UT,	
USA)	s	an	integrated	metabolic	measurement	system	for	maximal	O2	consumption	testing	and	indirect	
calorimetry	assessment.	The	TrueOne®	2400's	Analyzer	Module,	with	paramagnetic	oxygen	and	infra-
red	carbon	dioxide	analyzers,	is	designed	to	be	accurate,	reliable,	and	easy	to	use.	The	unique	flowmeter	
calibration	algorithm,	utilizing	an	image	reconstruction	technique,	corrects	the	non-linearity	of	the	
pneumotach	and	provides	highly	accurate	flow	measurement.		

Features:	

•	High	Precision	Flowmeter	Calibration	

•	Compact	Analyzer	Module		

•	Highly	Reliable	Mixing	Chamber	Principle	Recommended	Applications		

•	Athletic	Testing		

•	Exercise	Physiology	Teaching	and	Research		

•	Sports	Medicine	Research		

•	Energy	Expenditure	Assessment		

•	Differential	Diagnosis	in	Cardiopulmonary	Diseases	
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1.2	How	to	Calibrate:		Below	is	a	step-by-step	outline	for	calibrating	the	unit.		

Preliminary	Calibration	Steps	
1. Locate	the	power	switch	on	the	rear	of	the	Analyzer	Module	and	turn	it	on.	

a. Allow	it	30	minutes	to	warm	up	

	
	
2. Turn	on	the	computer	and	monitor	and	launch	TrueOne	software	

a. They	do	not	require	a	warm	up	time	of	more	than	2-minutes	
3. Assemble	the	water-trap	connection	

a. Connect	the	filter	to	the	T-connector	using	the	grey	connection	piece.	Gently	push	the	two	
together	in	a	circular	motion.	
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4. Attach	this	assembly	to	the	pneumotach.	Attach	by	pushing	the	water	trap	to	the	pneumotach	with	
slight	pressure.	Ensure	that	the	mixing	chamber	(tinted	rectangular	box)	does	not	fall	off	the	cart.	

	
	
5. 	On	the	other	end	(labeled	tube)	attached	one	end	of	the	hose.	
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6. Next,	assemble	the	T-mouthpiece	3-L	syringe	calibration	assembly.	Make	sure	the	small	white	
membranes	are	facing	the	same	direction.	Looking	at	image	#3	below,	when	holding	the	unit	with	
upright,	the	side	of	the	body	with	the	air-flow	arrow	facing	up	(small	arrow	on	the	center	body	
piece)	the	membrane	on	this	side	should	have	surface	parallel	with	the	long	water	chamber.		The	
membrane	on	the	opposite	side	should	be	facing	the	same	way.	If	you	are	having	trouble	use	this	
resource:	https://www.youtube.com/watch?v=YSg65afxMCM	

	

	
	
FINAL	PRODUCT	for	T-mouthpiece	3-L	syringe	calibration	assembly	
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7. Take	the	other	end	of	the	hose	(end	not	attached	to	the	water	trap)	and	connect	it	to	the	T-
mouthpiece	3-L	syringe	calibration	assembly.	Make	sure	the	hose	is	attached	to	the	output	valve	
(end	with	3	metal	rings).		

	

8. Next,	grab	the	3-L	syringe,	ensuring	it	has	the	grey	connector	attached	
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9. 	Interface	the	T-mouthpiece	3-L	syringe	calibration	assembly	with	the	grey	end	of	the	3-L	syringe.	
Make	sure	that	the	connection	is	tight,	however	do	not	forcefully	push	them	together.	Rather,	
gently	make	small	circular	motions	to	connect	them.		

	
	
10. Next,	prepare	for	gas	calibration	by	opening	the	gas	cylinder.	Turn	the	metal	knob	on	the	top	of	the	

cylinder	counterclockwise	1	and	½	turns.	The	Cal	Gas	calibration	is	key	to	accurate	testing	results.	
You	can	run	the	gas	calibration	as	many	times	as	needed	during	calibration.	It	is	recommended	to	
run	the	cal	gas	calibration	one	last	time	just	before	(gets	on	the	treadmill	or	ergometer)	testing	the	
subject.	We	need	to	ensure	the	CO2	levels	the	Parvo	cart	is	reading	for	room	air	have	not	floated	
above	3-4%.	If	this	happens,	the	RER	value	in	the	test	window	with	be	inflated	when	the	test	starts.	
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11. Now	you	can	attach	the	calibration	gas	hose/white	connector	from	the	cylinder	to	the	Cal	Gas	Port	
on	the	metabolic	cart.	This	is	located	on	the	back	of	the	unit.	It	is	to	the	left	of	the	Room	Air	port	
and	just	above	the	O2	Range	switch.	You	must	hold	the	front	of	the	unit,	so	it	does	not	fall	to	the	
floor,	while	bringing	the	calibration	gas	hose/white	connector	to	the	Cal	Gas	port.	Stay	parallel	to	
the	floor	and	push	the	connector	straight	in	the	port	connector.	To	remove,	push	down	lightly	on	
the	metal	clasp	and	pull	the	calibration	gas	hose/white	connector	away.

	
12. Now,	touch	pneumotach,	it	should	be	warm,	indicating	it	is	should	be	warmed	up.	Ensure	that	30-

minutes	has	passed,	and	contine	with	calibration	
	

13. The	system	is	now	ready	for	the	three	step	calibration.	Once	the	system	has	been	setup,	the	
calibration	process	is	very	quick	and	easy.	The	system	should	be	calibrated	again	in	between	
multiple	subjects	or	if	it	has	been	sitting	turned	on	but	not	used	for	a	long	period	of	time.	The	only	
calibration	step	theoretically	needed	after	initial	calibration	is	to	apply	the	calibration	gas	again.	
However,	the	enemy	of	the	pneumotach	is	moisture.	Excess	moisture	will	electrically	distort	what	
the	pneumotach	is	sensing;	this	will	be	reflected	in	erroneous	reading	of	the	3	liter	syringe	as	9,	12,	
15	liters	etc...	The	screen	inside	the	round	oven	needs	to	be	as	dry	as	possible,	so	you	may	have	to	
use	the	syringe	to	input	room	air	across	the	sensor	and	into	the	mixing	chamber	if	you	are	testing	
multiple	subjects.	The	pneumotach	is	very	sensitive	to	subtle	changes	in	CO2.	This	is	the	reason	why	
we	need	to	let	the	pneumotach	heat	up	to	operating	temperature.	Doing	a	test	with	a	cold	
pneumotach	will	have	distorted	CO2	results	–	the	RER	and	VO2	kg	readings	will	be	way	off.	
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1.3	FLOWMETER	CALIBRATION	
	

1. Open	TrueOne	software	and	click	“Flowmeter	Calibration”	
2. Enter	room	temperature,	relative	humidity,	and	barometric	pressure	readings	from	the	Vantage	

VUE	into	dialogue	box	on	TrueOne	

	
3. Click	and	open	Sample	Baseline	in	the	upper	right	corner	of	the	dialogue	box	
4. The	Flowmeter	Calibration	Processing	window	will	open.	All	input	strokes	will	be	done	with	the	

3-L	syringe.	

	
	
	

5. Detection	stroke	-	one	input	stroke	indicates	air	is	flowing	into	the	system	(mouthpiece	and	all	
assemblies	are	properly	configured).	*Notice	the	Flow	indicator	will	show	the	real	time	input	
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velocity,	Stroke	Peak	with	show	the	peak	in	real	time	and	in	the	blank	blue	field	beside	the	
Cancel	button,	the	volume	of	the	syringe	will	be	displayed	at	the	end	of	any	stroke.	This	value	
should	be	around	3	liters.	If	it	reads	high	–	9,	12,	15	liters	etc..	the	pneumotach	has	a	moisture	
issue	(if	testing	multiple	subjects	over	a	short	period	of	time)	and	must	be	allowed	to	dry.	You	
can	use	the	syringe	setup	to	do	the	Flowmeter	calibration,	but	don't	open	the	software.	You	are	
just	physically	driving	air	across	the	pneumotach,	through	the	mixing	chamber	and	into	the	
system	

6. Flush	Stroke	–	four	input	strokes	to	push	fresh	air	into	the	system	
7. The	pneumotach	can	sense	800	lpm.	Of	the	five	calibration	strokes	input	next,	two	must	be	less	

than	80	lpm.	The	number	will	fluctuate	beside	the	Flow	numerical	indicator	(to	the	left	of	Stroke	
Peak.	For	Exercise	Stroke	velocity	is	very	very	slow,	very	slow,	slow,	fast,	faster.	

8. Stroke	1	→	approximately	50	-80	lpm	(very,	very	slow)			
9. Stroke	2	→	approximately	100+	lpm	(very	slow)		
10. Stroke	3	→	approximately	200+	lpm	(slow)		
11. Stroke	4	→	approximately	300+	lpm	(fast)		
12. Stroke	5	→	approximately	400+	lpm	(faster)		
13. For	Resting	Stroke	velocity	can	stay	at	50	-80	lpm		
14. The	result	is	something	like	this	curve	
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1.4	GAS	CALIBRATION	

1. On	the	home	screen,	click	“Gas	Calibration”	
2. The	Gas	Calibration	window	will	open,	like	with	Flowmeter	calibration,	correctly	input	

temperature,	humidity,	and	pressure	into	the	dialogue	box.	Click	OK.	
3. The	unit	will	perform	gas	calibration	and	after	about	20	seconds.	
4. A	pop-up	will	appear	prompting	you	to	turn	off	the	calibration	gas.	
5. A	summary	window	(similar	to	the	one	pictured	below)	will	arise.	It	is	recommended	to	do	the	

Cal	Gas	calibration	until	you	get	the	exact	numbers	on	the	cylinder.	Also,	you	may	do	this	step	
just	before	your	subject	is	ready	for	testing	

6. Click	“Save”.	
7. When	done,	turn	off	the	calibration	gas	cylinder	by	turning	clockwise	hand	tight.	Then	bleed	of	

the	excess	left	in	the	regulator	and	the	calibration	gas	hose/white	connector	by	gently	pushing	
on	the	plastic	connector/opening	at	the	end.	Bleed	off	until	both	indicators	read	zero		
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1.5	TESTING	with	the	Parvo2400:	
	
1. Fit	participant	with	the	heart	rate	monitor,	the	heart	rate	transmitter	is	located	on	the	reticulated	

arm.	Be	sure	to	wet	the	strap	or	apply	electrode	gel	before	the	monitor	is	used.	
2. If	you	are	using	are	using	the	head	support	system,	attached	sweat	guard	to	the	front	of	the	system.	
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3. While	the	participant	is	seated,	fit	the	head	support	so	the	front	portion	is	just	above	the	eyebrows.	

Ensure	a	snug	fit.	Tighten	the	entire	band	around	the	head	using	the	knob	on	the	back.	You	will	be	
using	a	mouthpiece	and	nose	clip	with	this	setup.	Attach	a	rubber	mouth	adapter	to	the	small	white	
cylinder	of	the	mouthpiece	you	made	earlier.	You	want	to	avoid	the	subject	breathing	out	of	the	
corner	of	their	mouth	(when	at	maximal	exertion).	We	want	a	tight	seal	regardless	of	what	device	is	
used	-	head	support	or	full	mask.	

	
	
4. Give	the	subject	a	nose	clip	to	put	on	
	
	
5. They	are	ready	for	the	treadmill	or	ergometer.	Attach	the	hose	to	the	output	end	of	the	

mouthpiece.	Do	not	let	the	subject	insert	the	adaptor	yet.	When	it	is	time	to	start	the	test,	the	
subject	can	just	spin	the	adaptor	toward	their	face,	place	the	adaptor	in	their	mouth	and	begin	
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mouth	breathing	into	the	valves.	We	must	wait	until	the	appropriate	test	window	opens	for	the	
subject	to	do	this.	They	are	not	to	breathe	into	the	hose	at	this	time.	

	
6. The	full	face	mask	does	not	require	a	nose	clip	to	be	used.	To	use	this	piece,	switch	out	the	small	

white	cylinder	for	the	smaller	clear	adapter	(pictured	below).	Thread	the	end	of	the	small	clear	
adapter	into	the	front	hole	of	the	blue	face	mask.	Facial	hair	may	interfere	with	a	tight	seal.	Do	not	
hook	up	the	hose	to	the	full	face	mask	until	the	test	starts.	The	straps	wrap	around	the	head	and	
then	the	black	connectors	lock	into	the	clear	brackets	of	the	mask.	The	straps	are	adjustable	by	
sliding	the	strap	through	the	black	connector	the	using	Velcro	to	keep	in	place.	The	mask	covers	the	
mouth	and	nose	–	so	the	straps	need	to	be	tight	to	ensure	a	good	seal	
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1.6	METABOLIC	TESTING	
	
1. On	the	home	screen,	click	on	VO2/Metabolic	Testing.	
2. Input	participant	information.	Update	temperature,	humidity	and	barometric	pressure	if	it	has	

changed.	Choose	which	device	you	are	using.	

	
	

3. If	you	use	the	treadmill	you	need	to	choose	a	protocol.	You	can	create	a	new	one	and	name	it	
whatever	you	want.	Or,	modify	an	existing	one	and	save	it.	Use	what	is	there	already	from	the	pull	
down	menu.	Or	modify	a	protocol	and	not	save	it	by	just	clicking	OK.	

	
4. Treadmill	protocols	can	have	a	resting,	warm	up,	exercise	and	cool	down	phase.	If	you	do	not	want	

resting	or	warm	up	phases,	make	the	duration	=	0		.	
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5. Click	OK	
6. If	you	use	the	ergometer	you	also	need	to	choose	a	protocol.	You	can	create	a	new	one	and	name	it	

whatever	you	want.	Modify	an	existing	one	and	save	it.	Use	what	is	there	already	from	the	pull	
down	menu.	Or	modify	a	protocol	and	not	save	it	by	just	clicking	OK.	

	
7. You	have	similar	options	when	using	a	bike	choose	a	protocol	and	press	OK.	
8. Now	the	testing	windows	will	appear.	If	using	the	head	support,	you	can	attach	the	hose	from	the	

reticulated	arm/T	-	connector	to	the	output	connector	on	the	mouthpiece.	The	nose	clip	can	be	
worn.	Do	not	let	the	subject	breath	into	the	mouthpiece	yet.	If	using	the	full	face	mask,	do	not	
attach	the	hose	from	the	reticulated	arm/T	-	connector	to	the	mask	yet.	

9. A	series	of	software	windows	will	open	and	close.	
10. Then	this	window	will	open.	You	will	see	the	blank	test	results	window	open	as	well.	The	fields	will	

be	blank	because	the	subject	is	not	breathing	into	the	system	yet.	Wait	until	the	CO2	levels	exceeds	
0.03%,	then	click	OK.	

	
	
11. If	using	the	headgear,	the	subject	can	spin	the	mouthpiece	toward	their	face.	The	adaptor	can	be	

placed	in	the	mouth	while	the	nose	clip	is	on.	If	using	the	full	face	mask,	the	hose	from	the	
reticulated	arm/T	can	now	be	attached	to	the	input	connector	on	the	full	face	mask.	

	
	
12. 	There	will	be	a	delay	of	approximately	15	–	20	seconds	before	the	Metabolic	Measurement	Testing	

window	updates	with	data.	The	white	space	below	will	be	filled	with	data	every	5	seconds	(this	
resolution	level	can	be	changed)	
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13. The	Events	button	to	the	right	can	be	used	to	enter	RPE	values,	increased	wattage,	etc...a	pop-up	
window	will	appear.	Simply	enter	the	RPE	value	to	the	empty	data	field	in	the	pop-up.	This	new	
event	will	be	added	to	the	data	lines	in	the	white	space	below	

	
	

14. Well	documented	reports	are	available	after	testing.	To	the	right	of	the	Cancel	button	is	a	set	of	
timers.	This	will	show	overall	test	time,	rest	phase	time	left,	warm-up	phase	time,	and	exercise	
phase	time	left	as	you	go	through	the	stages	of	the	protocol	you	are	using.	After	the	test	you	can	
view	data	under	the	“Reports”	tab	on	the	home	screen.	
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1.7	CLEANING	EQUIPTMENT	
	
1.) While	wearing	gloves,	remove	headgear	or	the	full	face	mask	from	the	subject.	Remember	to	

keep	the	subject	attached	to	the	cart	for	about	20	seconds	after	the	test	has	finished.	This	
allows	software	delay	to	fill	in	the	remaining	data	

2.) Take	all	components	off	and	bring	to	grey	cart/sink	area	
3.) Detach	mouthpiece	from	headgear	
4.) Rinse	the	sweat	guard	under	water.	The	heart	rate	strap	and	transmitter	can	be	rinsed	as	well.	

Let	these	parts	air	dry	on	the	pegged	rack	
5.) Disassemble	the	mouthpiece	and	rinse	all	components	in	sink	with	Johnson	baby	soap	

		
6.) Rinse	in	______________	solution		

	
1.8	Contacts	
1. Parvo	Medics	

8152	South	1715	East	
Sandy,	UT	84093,	USA	

1800-942-7255	
2. Michael	Busa	–	Core	Director	

413-577-0574	
mbusa@umass.edu	



Updated:	16	October	2017	 Exercise	Intervention	&	Outcomes	Core	 19	

Chapter	3:	Monark	828	E,	weight	ergometer	
	
3.1	Introduction	

Monark	Ergometer	model	828	E	is	the	world’s	most	commonly	used	exercise	ergometer.	The	adjustable	
brake	system	and	the	force	can	be	set	and	read	Kiloponds	(kp)	and	Newton	(N).	The	result	of	the	
resistance	and	cadence	is	displayed	in	power	(Watts)	on	the	electronic	meter.	The	cycle	is	equipped	with	
an	electronic	meter	showing	pedal	revolutions	per	minute	(RPM),	heart	rate	in	bpm	(HR),	exercise	time	
in	minutes	and	seconds	(TIME),	speed	in	km	per	hour	or	miles	per	hour	(SPEED),	covered	distance	in	km	
or	mile	(DISTANCE),	burned	Calories	(CAL)	and	the	power	on	the	cycle	(WATT).	The	watt	level	depends	
on	pedalling	speed,	it	can	be	fine	tuned	by	increasing	or	decreasing	the	speed	or	pedal	rpm.	Each	828	E	
is	calibrated	at	the	factory.	This	means	that	you	can	begin	to	use	the	Ergometer	directly	after	assembly.	
However,	if	the	user	wishes	to	verify	the	scale,	please	read	the	instruction	for	“Calibration”	in	this	
manual.	

Quick	facts	about	the	874	E:	

•	Large,	well-balanced	flywheel	20	kg	(44	lbs)		

•	Pendulum	scale,	easy	to	calibrate		

•	Adjustable	seat	height		

•	Adjustable	handlebar	with	quick	release	lever		

•	Stable	frame,	solid	steel	tube		

•	Electronic	display	with	heart	rate	

Core	competencies:	

1) Understanding	the	brake	device	and	basics	of	the	tension	center	
2) Be	familiar	with	the	Fitness	computer	and	what	metrics	it	generates	
3) Review	service	actions	and	understand	what	actions	you	might	need	to	take	before/after	using	

this	equipment.	
	
3.2	User	Instructions		
	

Cycle	adjustments		
Seat	height	should	be	adjusted	to	a	comfortable	position.	The	appropriate	height	is	to	have	the	knee	
slightly	bent	when	the	sole	of	the	foot	is	centered	over	the	pedal	axle	with	the	pedal	in	the	bottom	
position.	To	adjust	the	seat	height,	loosen	the	lever	(1)	on	the	seat	tube.	See	Fig:	Adjustments.	Also	note	
that	the	handlebar	stem	should	be	inserted	into	the	frame	tube	at	least	3	inches.	This	measure	is	
marked	with	“MAX”	on	the	stem	(3).		
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Fitness	computer	
The	Monark	874E	is	equipped	with	a	Fitness	computer	that	displays	the	following	metrics:	

1. Revolutions	per	minute	(RPM)		
2. Heart	rate	in	bpm	(HR)	

a. At	the	display	for	heart	rate	(HR)	a	heart	symbol	is	lit	which	means	that	the	meter	is	trying	
to	find	a	pulse	signal	from	an	external	source,	chestbelt	with	electrodes,	If	the	meter	cannot	
find	such	a	signal	the	HR	function	is	automatically	turned	off	after	30	seconds.	When	the	
function	is	turned	off	the	heart	symbol	is	not	lit	any	more.	The	heart	rate	function	can	be	
turned	on	again	by	pressing	a	key.	

3. Exercise	bout	time	in	minutes	and	seconds	(TIME)	
a. The	timer	starts	automatically	when	pedals	are	moved.	Meter	values	for	Time,	Distance	and	

Calories	can	be	set	to	zero	by	pressing	the	RESET	button	(see	image	below	for	REST	button	
location)	for	more	than	two	seconds.	

4. Cycling	speed	in	km	per	hour	or	miles	per	hour	(SPEED)		
5. Covered	distance	in	km	or	miles	(DISTANCE)	
6. Calories	burned	(CAL)	and	power	(WATT)	are	also	displayed	on	the	computer.	To	get	correct	

readings	for	calories	and	watts,	the	kp-value	on	the	electronic	meter	(Fitness	computer)	has	to	be	
set	to	the	same	value	as	the	pendulum,	or	the	kpwindow	shown	to	the	left	of	the	electronic	meter.	

a. For	example,	the	pendulum	and	the	kp-window	is	showing	2	kp.	Press	the	kp-key	to	the	left	
on	the	meter.	The	lower	display	window	is	now	showing	figures	in	kp.	Increase	or	decrease	
in	steps	of	0.1	kp	by	pressing	the	kp-key	-	(arrow	up)	or	the	RESET-key	-	(arrow	down)	until	
the	reading	corresponds	with	the	actual	or	desired	kp-values	on	the	pendulum	scale	or	in	
the	kp-window.	After	that	press	the	CAL/WATTbutton	to	either	show	the	CAL-	or	WATT-
figures.	The	watt	reading	in	the	display	is	depending	on	the	pedalling	speed.	The	watt	
reading	can	then	be	fine	tuned	through	increase	or	decrease	of	the	pedalling	speed.	Calories	
are	calculated	all	the	time.	

	

	

Comment	[MB1]:	Make	a	video?	

Comment	[GP2R1]:	Made.	Waiting	on	YouTube	account.	
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To	activate	any	of	the	functions	described	above,	press	any	key	or	move	pedals.		

To	reset,	hold	the	RESET	key	for	two	seconds.	

Below	are	sample	and	images	of	the	Fitness	computer	and	a	table	outlining	metrics	the	computer	
displays	with	corresponding	units	and	ranges.	
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Scale-zero	adjustment	
Loosen	tension	device	so	that	the	brake	belt	feels	loose.	Check	that	the	pendulum	will	hang	in	vertical	
position.	

Scale	board:	Check	that	the	index	on	the	pendulum(2)	weigh	is		aligned	with	the	index	at	the	0-position	
on	the	scale	board.	If	adjustment	is	necessary,	first	loosen	the	locknut(1)	and	then	change	the	position	
of	the	board.	Tighten	the	lock-nut	after	the	adjustment.	See	fig:	Scale	adjustments.	

Kp-scale:	At	the	same	time,	check	that	the	kilopond-scale(5)	to	the	left	of	the	Fitness	computer,	shows	0	
in	line	with	the	index.	To	adjust	the	kp-scale	loosen	the	lockscrew	for	scale	indicator(9).	Tighten	the	
screw	firmly	after	the	adjustment.	See	fig:	Calibration,	Adjustment	kp-scale	window.
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Calibration	
Although	all	Ergometers	are	calibrated	at	the	factory,	the	user	may	wish	to	verify	this	by	performing	a	
mechanical	scale	calibration.	To	calibrate	follow	the	steps	below:	

1. Remove	the	blue	brake	belt	from	the	spring	
2. Lean	the	bike	forward	so	that	the	calibration	weight,	4kg(4)	is	hanging	independently	from	the	

frame	cover	
3. Be	sure	that	the	scale	board	is	set	to	zero	before	the	weight	is	put	on,	see	section	”Scale	-	zero	

adjustment”	
4. Put	the	4kg	weight	on	the	spring(6).	When	correctly	set,	it	should	be	possible	to	read	this	weight	

from	the	corresponding	place	on	the	scale	board(7).	See	fig:	Calibration	

Should	there	be	a	deviation	from	the	calibration	weight,	adjust	the	pendulum	to	the	correct	weight	on	
the	scale	by	means	of	the	adjusting	weight	inside	the	pendulum(3).	See	fig:	Scale	adjustment.	To	change	
the	position	of	the	adjusting	weight,	loosen	the	lock	screw(8)	on	the	back	of	the	pendulum	weight.	
Should	the	index	of	the	pendulum	weight	be	too	low,	move	the	adjusting	weight	upwards	in	the	weight.	
If	the	index	should	be	too	high,	the	adjusting	weight	is	moved	somewhat	downwards	and	locked	in	the	
new	position.	Repeat	until	the	correct	reading	(4kg)	is	achieved.	

Check	the	calibration	of	the	pendulum	weight	once	a	year	or	when	needed	
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Sample	Data	Sheet	for	Graded	Exercise	Test	

	

	

TIME	 DISTANCE	 SPEED	 HR	 RPM	 kP/meter/minàWatts	
(1kP/m/min=0.1634	
watts)	

1:00	 	 	 	 	 	

2:00	 	 	 	 	 	

3:00	 	 	 	 	 	

4:00	 	 	 	 	 	

5:00	 	 	 	 	 	

6:00	 	 	 	 	 	

7:00	 	 	 	 	 	
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3.3	General	troubleshooting	guide	

	

Maintenance	Schedule:	

Service	action:	

• Manufacturer	suggest	using	isopropyl	alcohol.	Use	a	damp	but,	not	wet	cloth	to	clean	the	
surface	you	wish	to	disinfect.	

• Periodically	wipe	the	surface	with	a	rust	preventative,	especially	when	it	has	been	cleaned	and	
the	surface	is	dry.	This	is	done	to	protect	the	chromeand	zinc	parts	as	well	as	the	painted	parts	
(4	times	per	year).	

• Check	now	and	then	that	both	pedals	are	firmly	tightened.	If	not,	the	threading	in	the	pedal	
arms	will	be	damaged.	Also,	check	that	pedal	arms	are	firmly	tightened	on	the	crank	axle,	
tighten	if	necessary.	When	the	Ergometer	is	new	it	is	important	to	tighten	the	pedals	after	5	
hours	of	pedalling	(4	times	per	year).	

• Check	that	the	pedal	crank	is	secure	to	the	crank	axle	(4	times	per	year).	
• Be	sure	that	the	pedals	are	moving	smoothly,	and	that	pedal	axle	is	clear	of	dirt	and	fibres	(4	

times	per	year).	
• When	cleaning	and	lubricating	be	sure	to	check	that	all	screws	and	nuts	are	properly	tightened	

(2	times	per	year).	
• Check	that	the	chain	is	snug	and	there	is	no	play	in	the	pedal	crank	(2	times	per	year).	
• Check	that	pedals,	chain	and	freewheel	sprocket	are	lubricated	(2	times	per	year).	
• Be	sure	that	the	brake	belt	does	not	show	significant	signs	of	wear	(2	times	per	year).	
• Check	that	the	handlebars	and	seat	adjustment	screws	are	lubricated	(2	times	per	year).	
• Be	sure	that	all	moving	parts	as	crank	and	flywheel	are	working	normal	and	that	no	abnormal	

play	or	sound	exists.	(I.e.	play	in	bearings	causes	fast	wearing	and	with	that	follows	a	highly	
reduced	lifetime.)	

• Check	that	the	flywheel	is	placed	in	the	center	and	with	plane	rotation.	
• The	crank	and	flywheel	bearings	are	long	term	greased	and	do	not	require	supplementary	

lubrication.	If	problem	arises	with	crank	or	flywheel	bearings,	contact	Monark	dealer.	
• Replace	batteries	if	the	computer	is	not	on/seems	to	be	producing	incorrect	measurements	
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3.4	Contacts	

1.)	Monark	Exercise	AB	(Vabsbro,	Sweeden)		
																				+46(0)281	59	49	40	
	

2.) Michael	Busa	–	Core	Director	
															413-577-0574	
															mbusa@umass.edu	
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Chapter	4:	Monark	874	E,	weight	ergometer	

4.1	Introduction:	Monark	Ergometer	model	874	E	is	a	safe,	easy-to	use	bike	for	fitness	testing	and	work	
tests.	It	has	a	brake	system	where	the	workload	is	determined	by	weights	added	in	the	weight	basket.	
The	patented	weight	basket	system	does	not	require	calibration,	the	precision	of	the	weights	ensures	
that	the	workload	is	correct.	

Quick	facts	about	the	874	E:	

•	Large,	well-balanced	flywheel	20	kg	(44	lbs)		

•	Adjustable	saddle	and	handlebar	

•	Stable	frame,	solid	steel	tube		

•	Wheels	for	easy	transport		

•	Electronic	meter	with	heart	rate	

Core	competencies:	

1) Understanding	the	brake	device	and	basics	of	the	tension	center	
2) Be	familiar	with	the	Fitness	computer	and	what	metrics	it	generates	
3) Review	service	actions	and	understand	what	actions	you	might	need	to	take	before/after	using	

this	equipment	
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4.2	User	instructions	

	 Cycle	adjustments		
Seat	height	should	be	adjusted	to	a	comfortable	position.	The	appropriate	height	is	to	have	the	knee	
slightly	bent	when	the	sole	of	the	foot	is	centered	over	the	pedal	axle	with	the	pedal	in	the	bottom	
position.	To	adjust	the	seat	height,	loosen	the	lever	(1)	on	the	seat	tube.	See	Fig:	Adjustments.	Also	note	
that	the	handlebar	stem	should	be	inserted	into	the	frame	tube	at	least	3	inches.	This	measure	is	
marked	with	“MAX”	on	the	stem	(3).		

	

Fitness	computer	
The	Monark	874E	is	equipped	with	a	Fitness	computer	that	displays	the	following	metrics:	

1. Revolutions	per	minute	(RPM)		
2. Heart	rate	in	bpm	(HR)	

a. At	the	display	for	heart	rate	(HR)	a	heart	symbol	is	lit	which	means	that	the	meter	is	trying	
to	find	a	pulse	signal	from	an	external	source,	chestbelt	with	electrodes,	If	the	meter	cannot	
find	such	a	signal	the	HR	function	is	automatically	turned	off	after	30	seconds.	When	the	
function	is	turned	off	the	heart	symbol	is	not	lit	any	more.	The	heart	rate	function	can	be	
turned	on	again	by	pressing	a	key.	

3. Exercise	bout	time	in	minutes	and	seconds	(TIME)	
a. The	timer	starts	automatically	when	pedals	are	moved.	Meter	values	for	Time,	Distance	and	

Calories	can	be	set	to	zero	by	pressing	the	RESET	button	(see	image	below	for	REST	button	
location)	for	more	than	two	seconds.	

4. Cycling	speed	in	km	per	hour	or	miles	per	hour	(SPEED)		
5. 	Covered	distance	in	km	or	miles	(DISTANCE)	
6. Workload	(kp	=	weight	basket	+	weight	in	kg)	can	be	set	which	gives	a	reading	of	calories	burned	

(CAL)	and	power	(WATT).	Energy	is	expressed	in	kJ	(kilojoule)	or	cal	(kilocalories,	kcal).	Conversion:	1	
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kCal	=	4,2	kJ.	Power	is	dependent	on	cadence,	or	pedaling	speed,	which	makes	it	possible	to	adjust	
the	workload/power	by	increasing	or	decreasing	cadence.	

a. To	get	correct	readings	for	calories	and	watts	the	kp	value	on	the	electronic	meter	has	to	be	
set	to	the	same	value	as	the	workload	that	is	the	weight	of	the	basket	including	the	weights	
in	it.	The	rubber	plates	are	included	in	the	calibrated	weight	of	the	1	kg	weight	basket.	

i. For	example,	the	workload	is	3	kg	(weight	basket	0,1	kg	+	2	x	1kg	weight).	Press	the	
kp	key	to	the	left	on	the	meter.	The	lower	display	window	is	now	flashing	and	
showing	figures	in	kp.	Increase	or	decrease	in	steps	of	0.1	kp	by	pressing	the	kp	
button	(arrow	up)	or	the	RESET	button	(arrow	down)	until	the	reading	is	
corresponding	with	the	actual	or	desired	kp	values	(workload)	from	the	weight	
basket.	After	that,	press	the	CAL/WATT	button	to	either	show	the	CAL	or	WATT	
figures.	Next,	press	the	CAL/WATT	button	to	either	show	the	CAL	or	WATT	figures.	
Refer	to	sample	images	below.	

ii. The	watt	readings	in	the	display	are	dependent	on	cadence.	The	watts	can	
accordingly	be	adjusted	by	increasing	or	decreasing	cadence.	Calories	are	calculated	
in	real-time.	

To	activate	any	of	the	functions	described	above,	press	any	key	or	move	pedals.		

	

Below	are	sample	and	images	of	the	Fitness	computer	and	a	table	outlining	metrics	the	computer	
displays	with	corresponding	units	and	ranges.	
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Heart	rate	
Using	the	Monark	chest-strap	heart	rate	belt	researchers	can	monitor	participant	heart	rate.	This	
technology	senses	electrical	output	of	the	heart	to	compute	heart	rate.	Properly	fitting	the	chest-strap	is	
integral	to	providing	accurate	readings.	

Before	harnessing	the	chest-strap,	clean	skin	where	the	belt	is	to	be	placed.	Additionally,	electrodes	on	
the	backside	of	the	strap	shoulide	be	moistened	with	water	or	specialized	gel.	The	chest-strap	should	be	
secured	at	a	comfortable	tension	around	the	participant’s	sternum,	see	Fig:	Placement	of	chest	belt	for	
visitation.	The	belt	should	be	placed	such	that	the	word	“Monark”	is	outward	facing,	upright,	and	
centered	on	the	participant’s	chest.	In	order	to	properly	connect	with	the	HR	receiver	on	the	bike,	the	
strap	should	not	exceed	100cm	in	distance	from	the	receiver.	It	is	especially	important	when	first	pairing	
the	chest	belt	with	the	receiver,	the	two	units	are	within	60cm	of	each	other.	

	 	 	 	 Figure:	Placement	of	chest	belt	

	

Wingate	testing	
When	using	this	piece	for	wingate	testing,	resistance	in	the	weight	basket	should	be	set	at	0.075	kg	per	
kilogram	of	the	participant’s	body	weight.	When	testing	highly-trained	athletes	consider	using	a	higher	
resistance,	for	example	1.0-1.3	kg	per	kilogram	of	participant	body	weight.		

After	the	participant	has	completed	a	3-5	minute	warm	up,	the	test	should	begin.	After	three	seconds	of	
all	out	pedaling,	the	brake	cord	is	to	be	released,	do	so	by	letting	go	of	cord.	This	will	apply	resistance	to	
the	system.	The	30-seconds	test	allows	for	calculating	the	following	variables:	

1.) Peak	power	(PP),	in	watts		
2.) Relative	peak	power	(RPP),	in	W/kg		
3.) Anaerobic	fatigue	(AF)		
4.) Anaerobic	capacity,	in	kilogram-Joules		
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Adjusting	the	brake	cord/belt	tension	
Important	note:	To	receive	correct	workload	metrics,	it	is	important	to	place	the	weight	basket	
according	to	the	description	that	follows.	If	the	basket	hangs	too	low,	it	may	touch	the	flywheel.	If	the	
basket	is	too	high,	wrong	workload	information	will	be	displayed.	 	

First,	check	that	the	brake	belt	is	lying	correctly	on	the	flywheel	brake	surface,	see	image	1	below	for	
proper	alignment.	Next,	put	4	kg	in	the	weight	basket	(4),	see	Fig:	Brake	device,	below.	When	rotating	
the	flywheel	by	hand,	or	when	pulling/releasing	the	brake	cord,	the	basket	should	lift/drop	between	40	
mm	and	60	mm.	If	this	is	not	the	case,	the	brake	belt	has	to	be	loosened	or	tightened	a	little	at	the	
tension	center.	

Loosen	the	cord	bracket	(#2	in	Figure	Brake	device)	so	that	the	cord	length	can	be	adjusted.	If	the	basket	
is	too	low,	shorten	by	tensioning	the	cord.	Alternatively,	if	the	basket	is	too	high,	lengthen	the	cord	by	
easing	tension.	

To	shorten	or	lengthen	tension,	turn	the	tension	center	(3)	approximately	45	degrees,	and	make	
appropriate	modifications	to	cord	length.	After	that	tighten	the	bracket	again,	and	check	that	the	
distance	between	the	weight	basket	and	flywheel	is	between	40	and	60	mm	when	you	pull	on	brake	
cord.	

Image	1:	Brake	belt	positioning	on	the	flywheel	
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Replacing	the	brake	belt	
If	the	brake	belt	needs	to	be	replaced,	loosen	the	brake	cord	and	set	the	basket	to	its	upper	position.	
Loosen	the	lock	washer	that	is	holding	the	cord	(#2)	and	remove	it	from	the	tension	center.	Loosen	or	
cut	off	the	knot	on	the	other	end	of	the	cord	and	then	remove	the	whole	cord	from	the	bike.	When	
assembling	a	new	brake	cord,	first	enter	one	end	into	the	hole	in	the	tension	center,	and	tie	a	knot	and	
let	the	knot	fall	into	the	bigger	part	of	the	hole.	Lock	the	end	of	the	cord	with	the	lock	washer.	
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Sample	Data	sheet	for	Wingate	Test	

Time	 	 RPM	 	 	

0:05	

0:10	

0:15	

0:20	

0:25	

0:30	

	

4.3	General	troubleshooting	guide	
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4.4	Maintenance	Schedule:	

Service	action:	

• Manufacturer	suggest	using	isopropyl	alcohol.	Use	a	damp	but,	not	wet	cloth	to	clean	the	
surface	you	wish	to	disinfect.	

• Periodically	wipe	the	surface	with	a	rust	preventative,	especially	when	it	has	been	cleaned	and	
the	surface	is	dry.	This	is	done	to	protect	the	chrome	and	zinc	parts	as	well	as	the	painted	parts	
(4	times	per	year).	

• Check	now	and	then	that	both	pedals	are	firmly	tightened.	If	not,	the	threading	in	the	pedal	
arms	will	be	damaged.	Also,	check	that	pedal	arms	are	firmly	tightened	on	the	crank	axle,	
tighten	if	necessary.	When	the	Ergometer	is	new	it	is	important	to	tighten	the	pedals	after	5	
hours	of	pedaling	(4	times	per	year).	

• Check	that	the	pedal	crank	is	secure	to	the	crank	axle	(4	times	per	year).	
• Be	sure	that	the	pedals	are	moving	smoothly,	and	that	pedal	axle	is	clear	of	dirt	and	fibers	(4	

times	per	year).	
• When	cleaning	and	lubricating	be	sure	to	check	that	all	screws	and	nuts	are	properly	tightened	

(2	times	per	year).	
• Check	that	the	chain	is	snug	and	there	is	no	play	in	the	pedal	crank	(2	times	per	year).	
• Check	that	pedals,	chain	and	freewheel	sprocket	are	lubricated	(2	times	per	year).	
• Be	sure	that	the	brake	belt	does	not	show	significant	signs	of	wear	(2	times	per	year).	
• Check	that	the	handlebars	and	seat	adjustment	screws	are	lubricated	(2	times	per	year).	
• Be	sure	that	all	moving	parts	as	crank	and	flywheel	are	working	normal	and	that	no	abnormal	

play	or	sound	exists.	(I.e.	play	in	bearings	causes	fast	wearing	and	with	that	follows	a	highly	
reduced	lifetime.)	

• Check	that	the	flywheel	is	placed	in	the	center	and	with	plane	rotation.	
• The	crank	and	flywheel	bearings	are	long	term	greased	and	do	not	require	supplementary	

lubrication.	If	problem	arises	with	crank	or	flywheel	bearings,	contact	Monark	dealer.	
• Replace	batteries	if	the	computer	is	not	on/seems	to	be	producing	incorrect	measurements	

	

4.5	Contacts	

1.)	Monark	Exercise	AB	(Vabsbro,	Sweeden)		
						+46(0)281	59	49	40	
	
2.)	Michael	Busa	–	Core	Director	
						413-577-0574	
						mbusa@umass.edu	
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Chapter	5:	Velton	Cycle	Ergometer	by	Racermate	
	
	

5.1 Introduction-	The	Velotron	is	a	laboratory-grade	cycle	ergometer	that	delivers	high	accuracy	and	
repeatability.		Built	with	RacerMate’s	signature	durability,	enjoy	the	most	realistic,	science	grade	
training	experience	on	the	world’s	most	advanced	cycle	ergometer.	Velotron	is	used	worldwide	by	
the	finest	universities,	sports	science	labs,	and	coaching	centers,	often	in	conjunction	with	powerful	
Wingate	software.	The	only	bicycle	ergometer	ever	approved	for	use	in	the	USA	Cycling	National	
Talent	Search,	Velotron	is	also	the	ultimate	cycling	trainer.		

	
The	Velotron	is	equipped	with	a	precision	load	generator,	providing	smooth	virtual	shifting-	pedal	
through	the	gear	shift,	with	no	wait	or	friction.	Secondly,	the	radical	flywheel	design	allows	for	
endless	coasting	for	a	true	road	feel,	with	a	current	drive	powerful	enough	to	deliver	the	widest	
spectrum	of	load	resistance.	

	

POWER	GENERATOR 	
	
	

FLYWHEEL	 	
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5.2	Core	Competencies		
	
Getting	started	with		Velotron	Coaching	Software	

1.) Connect	EXT	PC	cable	to	the	appropriate	spot	on	the	back	of	the	power	generator	

		
2.) Attach	opposite	end	(stereo	to	USB	adaptor)	to	USB	on	Exercise	testing	laptop	

	
	

3.) Open	Velotron	Coaching	Software	(CS)	2008	from	the	start	menu	

	
4.) Go	to	Source	menu	and	select	Real-time	
5.) If	this	is	your	first	use,	select	“New”	on	sub-directory	of	Real-time	in	Source	menu	

a. Create	a	user	data	file,	enter	user	information	and	saveàOK.	On	subsequent	uses	select	
Open	to	choose	this	user	file.	If	there	is	more	than	one	user,	create	a	User	Data	File	for	
each	person	who	will	use	the	Velotron.	
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6.) Go	to	Utilities	menu,	select	“Comm	Ports”	to	determine	what	serial	port	Velotron	is	connected	

to.	With	this	information,	select	Source	-	Real-time	-	Comm	Port	and	verify	the	correct	port	
found	in	the	test	has	been	set.	

	
7.) Select	the	Options	menu	to	setup	your	Manual	Ergo	settings,	Screen	Capture	Options,	Drag	

Factor™	settings,	Reports,	and	decide	whether	you	want	to	run	the	test	in	Miles	Per	Hour	or	
Kilometers	Per	Hour.	

8.) Select	Start,	then	Charts,	Manual	Ergo,	Mode,	or	SpinScan.	By	opening	Charts	a	selection	
window	for	the	courses	or	tests	you	want	to	use	for	your	test	will	appear.	Select	a	course	from	
the	“Courses”	folder	from	the	Velotron	CS	2008	directory.	Then	click	on	Open,	the	Chart	screen	
will	appear	with	this	selection.	

9.) By	selecting	a	course	this	will	open	the	desired	course	in	the	Charts	Screen,	click	the	red	or	
green	buttons	on	the	left-hand	side	of	the	chart	window	to	enable	or	disable	the	various	
channels	of	data.	

10.) 	Hit	F1	on	the	Velotron	Handlebar	Controller	to	start	the	timer.	The	course	or	test	will	start.	
11.) Below	is	a	general	overview	of	the	chart	features:	
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a. Full	array	of	data	taken	directly	from	a	Velotron	saved	performance	file.		
b. Current,	Peak	and	Average	display	of	data.	HR	zone	%	and	PulsePower™,	Gear	and	

Gearing.		
c. User	selectable	color	graphs	that	correspond	to	the	data	section.		
d. Time	Indicator	Bar	to	pinpoint	exact	time	coordinates.		
e. Course/program	profile	for	Real	Time	use	to	indicate	current	position,	or	workload.		
f. Multiple	Zoom	Levels	in	File	Mode	operation.		
g. RPM	zone	pointer	to	help	maintain	a	fixed	RPM	during	any	test.	It	is	ideal	for	fixed	

wattage	tests.	
Concluding	a	test	

1.) When	you	have	completed	your	test,	you	can	either	reset	the	timer	and	run	a	new	test,	or	save	
the	performance	data	as	a	permanent	record.	

a. At	the	conclusion	of	a	known	length	test	a	dialog	will	appear	asking	you	to	“Reset	or	
Save.”	

b. If	the	test	is	open-ended	you	would	press	the	F5	(reset)	button	to	prompt	a	“Save,	
Reset,	or	Cancel”	(Cancel	added	in	case	you	pressed	F5	by	mistake).	These	questions	
can	be	answered	using	the	Handlebar	Controller	keys	shown	in	the	dialog	to	eliminate	
having	to	dismount	the	bike	

	
Saving/Viewing/Exporting	a	test	

Performance	files	in	CS	are	saved	as	.vel	files.	Vel	file	extensions	are	created	whether	the	test	
was	an	ERG	file,	CRS	file,	or	saved	SpinScan	session.	The	performance	files	will	be	saved	with	a	
User	Name/	Course	or	test	type/Date/Time.vel	format.	
	
1.) Press	RESET	after	the	completion	of	a	test	to	display	the	“Do	you	want	to	save”	dialog.	

Answer	Yes.	
2.) Using	the	Handlebar	Keys,	press	F1	to	Save	or	F2	not	to	save.	
	
3.) Exporting	the	data.	Saved	Race	Files	from	any	Velotron	PC	program	(available	on	your	hard	

drive)	can	be	exported	as	ASCII	text	files.	This	can	be	done	automatically	or	manually.	If	you	
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always	want	an	export	performance	files	after	a	test	(for	use	in	3rd	party	applications)	check	
the	AutoExport	option	in	the	Export	Options	menu.	For	manual	export	choose	File,	then	
select	either	the	Export	function	or	change	the	Export	Options	as	needed	(check-mark	both	
”short	format”	&	“comma	delimited”	in	the	options	if	you	plan	to	use	these	export	files	in	a	
spreadsheet).	You	will	be	asked	to	select	the	original	saved	performance	file.	You	can	then	
browse	to	any	folder	where	the	file	may	reside.	Once	exported,	these	files	have	the	same	
name	as	the	original	file,	but	with	a	new	.txt	file	extension.	

4.) To	open	a	performance	report,	select	File,	Open	Report,	and	navigate	to	the	desired	file	and	
select.		

	
	

	
File	Mode,	viewing	saved	race	files	
	

1.) Select	“Saved	File”	from	the	Source	menu.	
2.) Select	Options	and	check	or	uncheck	Metric	as	desired.	
3.) Select	Start,	then	Charts,	and	you	will	be	presented	with	a	window	where	you	can	browse	to	

any	folder	from	the	“Look	In”	drop	down	window	to	select	a	saved	performance	file.	This	will	
open	in	the	background,	therefore	minimize	CS	2008	and	open	this	dialogue	box.	Once	the	file	is	
found,	highlight	it	and	select	Open.	The	chart	screen	will	appear	with	the	race	data	showing	in	
it’s	entirety.	To	open	another	file,	press	Ctrl	-	O.	

4.) Click	the	red	or	green	buttons	on	the	left-hand	side	of	the	chart	window	to	enable	or	disable	the	
various	channels	of	data.	
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5.) You	can	now	move	the	mouse	left	and	right	over	the	data	and	zoom	in	and	out	with	the	left	and	
right	mouse	buttons.	Right-click	your	mouse	for	Full	Zoom	In,	and	scroll	forward	and	back	
through	the	data	by	moving	the	Time	Indicator	Bar	from	the	left-hand	or	right-hand	side	of	the	
Chart	Window,	or	establish	a	Zoom	Window	using	the	left/	right	and	up/down	arrow	keys	of	
your	PC	keyboard	and	hit	Enter	to	activate	this	level	of	zoom	

	
	
Creating	a	new	course/program	
Because	course	files	must	retain	the	format	as	shown	in	the	image	on	the	previous	page,	it	is	
recommended	to	edit	one	of	the	preexisting	courses	when	making	a	new	course.	This	will	almost	
guarantee	a	usable	course	every	time.	
	

1.) To	create	a	new	course	from	an	existing	course	while	in	Notepad,	first	open	a	preexisting	
course.	

a. To	open	a	preexisting	course,	open	Notepad	from	the	Start	menu	
b. In	Notepad,	click	File,	then	Open	
c. Navigate	to	Velotron	CS	2008	folder	on	the	C	drive,	then	open	the	Courses	subdirectory	
d. By	default	Notepad	looks	only	for	“text	files”,	but	if	you	left-click	on	the	down	arrow	in	

the	“Files	of	type:”	section	and	choose	“All	Files	(*.*)”,	then	all	the	files	in	this	folder	will	
appear.	Select	the	course	the	you	desire	to	amend	and	click	Open	
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e. When	the	course	you	want	to	edit	is	open	in	Notepad,	rename	it	by	clicking	File,	Save	

As.	Type	a	new	name	for	this	course	and	choose	All	Files	(*.*)	extension	when	saving	
new	course.	

f. Left	click	Save	to	make	a	“carbon	copy”	of,	and	close,	the	first	opened	course.	
g. Now	you	can	proceed	with	changes	to	make	to	your	new	course:	

i. Generally,	to	amend	a	course	change	parameters	from	the	original	course.	
Follow	the	formatting	instructions	outlined	below:	

	

	
h. When	finished	editing,	click	File/Save.	
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5.3	Getting	started	with	Velotron	Wingate	Software	
	

1.) Go	to	the	Start	menu	and	open	Velotron	Wingate	

	
2.) Go	to	Client	menu	and	select	New	Database		
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3.) Next,	go	to	Client	menu	and	select	New	Client		
a. Enter	the	database	that	you	want	data	to	be	saved	to,	enter	subject	antropometric	

measures	and	apply	one	of	the	following:	1.)	torque	factor,	2.)	Torque	value,	3.)	
Dropped	weight	

b. OK	to	save	

	
4.) 	Now,	go	to	Wingate	menu,	and	select	Create	new	protocol		

a. Create	a	name	for	protocol	and	edit	testing	parameters	
b. Ok	to	save	to	desired	pathway.	Suggested	to	save	in	client	data	folder	
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5.) Select	Wingate	menu	and	click	Graph	Scaling.	Edit	Watts	and	HR/	Cadence	Scaling	
6.) Check	that	Velotron	is	plugged	in	to	computer	(see	above).	Select	Setup	menu	and	click	run	Test	

Comm	Ports.	Note	which	Comm	in	connected	to	Velotron.	Click	OK.	Next,	click	Setup	menu,	and	
select	Comm	Port,	verify	that	this	setting	matches	Test	Comm	Ports	results.	See	above	section	
for	images.	

7.) Go	to	Client	menu,	select	Load	Client	and	navigate	to	client	data.		
a. Go	to	C-drive,	VeloTron	Wingate	2008	folder,	data	folder,	select	your	desired	database	

folder,	and	select	and	open	client	folder		
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8.) Now,	select	Load	Protocol	from	Wingate	menu.	Navigate	to	the	protocol	you	made	in	step	4.	

	
	

9.) Next,	go	to	Wingate	menu	and	click	Run	Wingate	
a. The	Velotron	is	now	is	“Warm-up	mode.”	The	client	can	warm-up	using	the	preselected	

load	-or-	by	using	the	Up/Down	buttons	on	the	Wingate	Screen	or	those	on	the	Velotron	
Handlebar	Controller	adjust	the	workload	to	suit	the	warm-up	requirements.	Due	to	x-
axis	scaling	limitations	there	is	only	about	20	seconds	of	warm-up	shown,	but	the	warm-
up	period	prior	to	starting	the	clock	is	open-ended.	
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10.) When	you	are	ready	to	begin	the	test,	select	the	Start	Wingate	button,	the	first	icon	on	the	
toolbar		

START	
a. The	warm-up	phase	that	you	selected	will	begin,	then	a	red	countdown	timer	will	

appear	in	the	upper	right	hand	corner,	indicating	when	the	load	will	be	applied		
b. At	the	end	of	the	test	a	plot	of	the	client’s	performance	will	appear.	Click	the	Reset	

button,	fourth	button	from	the	left	on	the	toolbar.	Select	the	pathway	where	you	like	to	
save	the	performance.	Suggested	saving	location	is	the	original	client	data	folder		

RESET	
	
File	mode,	viewing	and	exporting	saved	data	

1.) Return	to	the	Wingate	software	homepage	
2.) To	view	data	in	file	mode,	in	the	Tree-view	diagram	on	the	right	side	of	the	page	select	your	

database,	then	client,	and	finally	the	client	performance	file		
a. Right	click	on	the	performance	file	and	choose	plot.	A	Plot	will	appear	in	the	right	panel.		
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3.) To	export	data,	return	to	the	tree-view	diagram	and	right	click,	but	select	export.		
a. A	dialogue	box	will	appear	that	notes	where	the	file	has	been	saved	

	
b. The	program	will	export	the	performance	file	in	comma	separated	text	format	into	the	same	

database	folder	the	original	performance	file	was	found.	The	file	will	have	the	same	file	
name,	but	with	a	TXT	file	extension.	These	files	can	be	used	Microsoft	excel.		

	
5.4	Contacts		
	

1.) Velotron	forums:	https://www.racermateinc.com/help-center-faq/	
2.) Michael	Busa	–	Core	Director	

413-577-0574	
		 mbusa@umass.edu	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	



Updated:	16	October	2017	 Exercise	Intervention	&	Outcomes	Core	 48	

Chapter	6:	Quinton-55	EKG	Stress	System	
	

6.1.	Introduction-	Importance	of	Electrocardiograms	
As	the	heart	is	a	muscular	pump	comprised	of	four	chambers,	it	requires	electrical	
stimulation	to	control	the	muscular	contractions	and	flow	of	blood	throughout	the	
body.		An	electrocardiogram	is	a	method	typically	used	to	assess	electrical	conduction	in	
the	heart.		This	simple	non-invasive	test	allows	to	check	for	normal	rhythms,	rates	and	
proper	conduction	of	electrical	impulse	throughout	the	cardiac	tissue.		This	manual	will	
allow	a	researcher	to	understand	and	utilize	the	EKG	system	in	order	to	obtain	EKG’s	for	
medical	interpretation.		For	all	subjects	>70	years	of	age	or	if	a	subject	has	≥2	
cardiovascular	risk	factors,	an	EKG	must	be	completed	prior	to	beginning	exercise	
protocols.	
	

6.2	EKG	Settings	
Unless	specifically	requested	otherwise,	EKGs	should	be	run	with	the	following	standard	
settings:		
Paper	Speed:	25	mm/sec		

Calibration	Standard:	1mV	=	10mm		
Rhythm	Lead:	Default	Lead	II	

	
6.2.1	Skin	Prep	
Patients	with	excessive	chest	hair	should	be	shaved	at	the	electrode	site.	Abrade	these	
areas	with	fine	sandpaper	or	an	abrasive	pad,	and	then	clean	with	alcohol-saturated	
gauze.	Allow	the	skin	to	air	dry	before	placing	electrodes.	Be	sure	the	subject	does	not	
have	any	jewelry	that	could	interfere	with	the	tracings	(necklaces,	piercings	etc.).	
	

6.3	Limb	Lead	Placement		
RA	(White)	–	Right	Arm	electrode	is	placed	on	a	distal	portion	of	the	right	lateral	side	of	
the	upper	arm	below	the	shoulder.		
LA	(Black)	–	Left	Arm	electrode	is	placed	on	a	distal	portion	of	the	left	lateral	side	of	the	
upper	arm	below	the	shoulder.		
RL	(Green)	–	Right	Leg	electrode	is	placed	on	the	inside	calf,	midway	between	knee	and	
ankle.		
LL	(Red)	–	Left	Leg	electrode	is	placed	on	the	inside	calf,	midway	between	knee	and	
ankle.		
	

6.4	Precordial	Lead	Placement		
V1	(COLOR)	–	4th	intercostal	place	at	the	right	margin	of	the	sternum.		
V2	(COLOR)	–	4th	intercostal	place	at	the	left	margin	of	the	sternum.		
V3	(COLOR)	–	Midway	between	V2	and	V4	(on	top	of	the	5th	rib).		
V4	(COLOR)	–	5th	intercostal	place	at	the	left	mid-clavicular	line.		
V5	(COLOR)	–	At	the	horizontal	level	of	V4,	at	the	left	anterior	line.		
V6	(COLOR)	–	At	the	horizontal	level	of	V4,	at	the	mid-axillary	line.	
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NOTE:	Lead	placement	does	affect	the	EKG	waveform.	When	the	limb	leads	are	placed	
on	the	torso,	waveform	changes	might	be	seen	in	the	QRS	amplitude,	axis	shift	occurs,	Q	
waves	can	be	seen,	and	T	waves	might	appear	flipped	or	flattened.	These	changes	are	
clinically	significant	in	that	they	are	associated	with	cardiac	ischemia.	If	a	non-standard	
lead	placement	is	used,	note	the	variation	in	the	EKG	comment	field.		

	
	
6.5 Inputting	a	New	Patient	

a. To	initialize	the	Q-stress	program,	click	on	the	icon	on	the	desktop	
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b. To	first	search	for	previous	patients,	click	the	patient	icon	

	
	

c. Search	for	the	patient	name	or	MRN	(Medical	Record	Number)	
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d. If	patient	information	is	not	found,	Select	“New”	and	input	patient	data	

	
	

e. The	following	screen	will	allow	you	to	enter	all	possible	demographic	information.		Click	OK	
when	completed	to	complete	the	data	entry.	Also	note	there	should	be	no	changes	made	to	
protocol,	procedure,	or	report	unless	instructed.	
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6.6 Check	Lead	Placement	and	Artifact	

a. After	patient	data	is	complete,	click	on	the	light	blue	icon	to	check	lead	placement	and	
connections.	

	
	

b. Click	“Start”	and	wait	for	the	icons	to	change	color	

	
	
NOTE:		Leads	should	be	in	the	“good”	range	

c. If	Leads	are	not	within	acceptable	“good”	range,	remove	leads	and	prep	the	electrode	sites	
again	
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d. Click	exit	after	all	leads	are	properly	placed.	

	
	

6.7 Baseline	Waveform	
a. After	the	leads	are	placed	and	the	patient	data	is	input,	click	on	the	rest	icon	to	begin	resting	
waveforms.	

	
	
	



Updated:	16	October	2017	 Exercise	Intervention	&	Outcomes	Core	 54	

	
	
	
	
	
	

b. The	screen	will	begin	to	display	heart	rate	and	EKG	waveforms.		Allows	about	10	seconds	to	pass	
before	collecting	a	resting	EKG.	

	
	

c. Press	F5	to	print	out	a	full	12-lead	resting	EKG	
d. Press	F6	to	print	the	current	3-lead	screen	
e. To	begin	exercise	protocols	click	on	the	“start	belt”	icon	followed	by	the	start	exercise	button	
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f. To	end	exercise	protocols	click	the	start	recovery	button	followed	by	the	“stop	belt”	button	

	
	

g. To	review	the	collect	EKGs	click	the	review	tab	and	click	“Yes”	
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h. Click	yes	when	entering	review	mode.		This	will	end	the	test.	
	
	
	
	
	
	
	
	

i. When	the	test	has	ended,	if	a	report	is	need	click	“Partial	Report”	
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This	will	print	a	summary	report	of	the	procedure	
	

j. When	finished	reviewing,	click	“Exit”	to	save	the	test.		When	prompted,	be	sure	PDF	is	clicked	
yes,	and	press	“OK”	

	
	
	
	
	
	
	

k. To	exit	current	patient,	press	“Exit”	again	



Updated:	16	October	2017	 Exercise	Intervention	&	Outcomes	Core	 58	

	
	

After	obtaining	a	baseline	waveform,	the	EKG	should	be	interpreted	by	a	medical	
professional.		The	interpretation	will	be	completed	by	either	a	certified	clinical	exercise	
physiologist	(CCEP)	or	medical	doctor	(MD)	within	the	department.			
	
An	exercise	physiologist	may	interpret	the	baseline	waveforms	with	some	restriction.		If	the	EKG	
is	determined	to	be	satisfactory	and	without	contraindications	to	exercise,	the	exercise	portion	
will	resume	without	referral	from	the	medical	doctor.		However,	if	the	exercise	physiologist	
determines	that	the	baseline	waveform	is	questionable	in	any	way	(based	on	current	ACSM	
recommendations	to	exercise),	the	medical	doctor	should	be	consulted	to	verify	the	EKG.		The	
doctor	will	then	determine	whether	or	not	to	proceed	with	testing.		Questionable	baseline	EKG’s	
can	include	but	are	not	limited	to:	frequent	ectopy,	abnormal	heart	rates	(<40bpm	or	>100bpm	
at	rest),	ST	segment	abnormalities	<2mm	depression	or	conduction	delays.			
	
Subjects	with	significant	abnormalities	will	be	excluded	from	the	study.		Significant	EKG	
abnormalities	may	include	but	are	not	limited	to:	dysrhythmias,	electronically	paced	rhythms,	
conduction	blocks,	>1mm	ST	segment	elevations	or	>2mm	ST	segment	depressions.			

	
6.8 Exercise	Protocols	

As	there	is	no	continuous	EKG	monitoring	during	CADENCE-Adults,	protocol	is	not	significant	when	
collecting	EKG’s.		EKG	will	be	an	“as	needed”	procedure	to	ensure	safety.	

	
6.9 Follow-Up	

If	at	any	time	during	testing	protocols,	a	subject	becomes	dizzy,	lightheaded	or	complains	of	chest	
pain,	a	follow-up	EKG	should	be	performed	along	with	blood	pressures.		Interpretation	of	the	EKG	
should	be	immediately	referred	to	the	Exercise	Physiologist	or	MD	on	site.			
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6.10 Cleaning	

All	wires	and	connections	should	be	wipes	with	disinfecting	wipes.		Used	electrodes	should	be	
thrown	away.		The	treadmill	and	any	other	equipment	associated	with	the	test	should	be	thoroughly	
cleaned	between	participants	with	alcohol	wipes.			
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Chapter	X:	

Biodex	System	4	Pro	Dynamometer	

	

Turning	things	on:	

1.	Make	sure	the	Biodex	is	plugged	in.	

2.	Turn	on	the	main	power	switch	(located	on	the	bottom	left	of	the	back	of	the	Biodex	cart)	by	flipping	
it	from	O	to	I.	

	

3.	Turn	on	the	power	for	the	computer	and	dynamometer	(green	switches	on	the	bottom	right	of	the	
back	of	the	Biodex	cart)	by	flipping	them	from	O	to	I.	

	

	

4.	Turn	on	the	computer	tower.	

	

Basics	of	setting	up	the	Biodex	

The	dynamometer	and	the	Biodex	chair	can	be	translated	in	space	side	to	side	and	vertically	and	
rotated.	The	following	images	point	out	how	to	move	the	chair	and	dynamometer.	
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Tilt	the	dynamometer	head	by	
loosening	this	knob.	

Comfort	stop	button.	Pushing	this	
button	will	immediately	stop	a	test	
and	exit	out	of	testing	mode.	Use	
as	a	kill	switch	only.	
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This	knob	is	used	to	tilt	the	seat	
back	

This	lever	is	used	to	rotate	the	seat	

When	putting	attachments	on	
dynamometer,	these	dots	must	
align.	You	can	rotate	the	
dynamometer	dot	using	the	blue	
buttons	on	the	dynamometer	head	

Watch	out,	fingers/hands	
are	crushable!	

Attachments	without	a	nut	
on	them	will	use	the	
attachment	handle	stored	
on	the	dynamometer	head	
(see	above)	Letter	corresponds	to	side	

(left/right)	you’re	testing	
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Running	a	Test	in	Biodex	Advantage:	

These	instructions	will	take	you	through	running	a	test	on	the	Biodex.	If	you	wish	to	use	the	Exercise	or	
Biofeedback	modes,	please	see	the	instructions	in	the	Biodex	user	manual	or	help	documentation.	

1.	When	the	computer	boots	up,	it	will	ask	you	to	initialize	the	dynamometer.	Remove	any	attachments	
(the	attachment	post	will	rotate)	and	click	OK.	The	dynamometer	will	then	initialize.	

	

	

	

	

2.	Biodex	Advantage	usually	boots	up	to	the	last	test	that	was	run.	

A.	If	you	need	to	see	how	to	set	up	the	biodex	attachments	for	a	given	test,	click	the	
“Anatomical”	button.	In	the	window	that	pops	up,	you	can	select	the	joint	and	joint	motion	
you’re	testing	to	see	a	video	of	how	to	set	up	the	machine.	
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	 B.	Before	starting	a	new	test	you	need	to	load	a	“patient”	and	select	a	protocol.	Follow		 the	
buttons	on	the	left	from	1-4.	As	you	go	through	the	steps,	the	active	window	will	be		 yellow.	

	

	

	

1.	Select	a	joint	and	motion	
2.	Select	a	method	to	view	the	
instructions	

3.	Click	view	
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3.	The	Patient	window	gives	you	options	to	open	an	existing	patient,	add	a	patient,	or	edit	an	open	
patient.	

	

	

	 	

	 	

	

To	start	a	test,	
click	here	first	

	

To	view	instructions	
for	how	to	set	up	a	
given	test,	click	here	

	
Not	ready	because	you	
have	to	go	through	the	
test	setup	first	
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A.	If	you	click	“Open,”	you	can	see	a	list	of	existing	entries	and	select	one	to	create	a	new	testing	
session	for.	If	you	select	a	patient	from	this	list,	you	can	begin	a	new	test	by	clicking	the	“NEW”	
button	or	EDIT	the	patient’s	information.	If	a	patient	has	existing	tests,	you	can	REPEAT	one	of	
these,	print	a	report	for	an	existing	test,	or	DELETE	an	existing	test.	

	

	

	 B.	If	you	click	“Add	Patient,”	the	window	will	change	to	the	view	below.	At	minimum,	
	 you	must	fill	out	any	information	boxes	that	are	in	red.	NOTE:	Personal	identifying	
	 information	should	never	be	entered	into	the	Biodex	software.	Only	enter	study	
	 participant	IDs	into	name	fields.	Never	enter	names,	birthdates,	age,	address,	phone	
	 number,	or	other	information	that	could	identify	an	individual.	Weight	and	gender	are	
	 required	by	Biodex	and	can	be	entered.	
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	 C.	After	entering	all	necessary	patient	information,	click	“Save,”	and	then	click	on	
	 “Protocol.”	
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4.	Here	you	can	load	a	protocol,	add	a	protocol,	or	edit	a	selected	protocol.	

	

	

	 	

	

Option	buttons	
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A.	If	you	click	the	 	button,	the	following	window	will	pop	up.	Here	you	can	view	built-in	
or	previously	designed	testing	protocols.		
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B.	If	you	want	to	create	a	new	protocol,	click	the	 	button.	This	will	activate	the	
	 editable	portions	of	the	protocol	pane.	

	

i.	Depending	on	the	“Study	Type”	and	“Mode”	options	you	choose,	the	other	options	in	
the	blue	box	above	will	change.	For	example,	if	you	change	from	Isometric	mode	to	
Isokinetic	mode,	instead	of	“#	Positions,”	the	green	box	will	be	labeled	“#	Sets.”		

	 	

	

	

If	you	click	this,	these	
options	become	available	
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5.	After	you	select	a	protocol,	click	on	the	“Set	ROM”	button.	At	this	point,	the	chair	and	dynamometer	
should	be	in	position,	the	correct	attachment	should	be	on	the	dynamometer,	and	the	participant	
should	be	seated	and	strapped	in.	

	 A.	Below	is	the	“Set	ROM”	window.	Follow	the	blinking	red	text	through	each	step.	

	

	

	

	

	

	

	

	

	

1.	First,	select	the	
side	being	tested	

	

Using	this	option	is	not	
recommended	(generally	only	
available	when	switching	from	
one	side	to	the	other	in	bilateral	
protocols)	

	 2.	Click	CLEAR	LIMITS.	Set	
AWAY	and	TOWARD	limit	
by	moving	participant’s	
limb	to	these	positions,	
holding	there	(see	below),	
and	clicking	the	SET	button.	
Note	that	this	sets	the	
range	that	the	participant	
will	be	tested	in.	

	

3.	Move	limb	to	Anatomical	
Reference	position,	hold	there,	
and	click	the	Calibrate	Position	
button.	Anatomical	Reference	
can	be	changed	by	clicking	on	the	
button	that	reads	“90”	here.	

4.	Move	limb	to	AWAY	limit,	
hold	there	(using	hold	button),	
have	participant	completely	
relax	limb,	and	click	the	Limb	
Weight	button.	If	you	get	an	
error	on	this,	see	text	below	in	
i.	

	

5.	Click	Continue	View	Setup	button	will	show	a	
schematic	of	what	“AWAY”	and	
“TOWARD”	are,	as	well	as	how	
angles	are	referenced	
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i.	Clicking	“Limb	Weight”	may	give	the	following	error:	

	

ii.	If	this	occurs	and	the	limb	was	weighed	at	the	AWAY	limit,	you	will	need	to	increase	
the	AWAY	limit,	move	the	limb	to	this	position,	and	weigh	again.	If	the	AWAY	limit	is	
already	at	the	participant’s	limit	for	the	given	test.	

	

6.	After	hitting	“Continue”	in	the	Set	ROM	window,	the	program	will	move	on	to	testing.	The	program	
will	switch	to	the	following	window	and	wait	there	until	you	hit	START.	If	Start	is	not	an	option,	it	means	
you	missed	something	between	step	3	and	this	step.	When	you	are	ready	to	begin	your	test,	click	START.	

	

A.	If	you	want	to	change	the	visualization	for	a	test	(e.g.,	bar	graph	instead	of	line),	click	on	the	

options	 	button.	

	

	

Hold	button	can	hold	
participant’s	limb	in	a	
position.	
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	 B.	First,	a	trial	reps	window	will	appear.	Here,	the	participant	can	
	 practice	the	motion	and	speed	of	the	test	before	the	program	starts	
	 collecting	data.	When	you’re	ready	to	start	the	real	reps/sets,	have	
	 the	participant	hold	their	limb	in	the	start	position	(usually	
	 TOWARD	limit).	

	

	 C.	Once	the	participant	holds	at	the	start	position	for	a	sufficient	
	 time,	the	test	will	begin.	You	will	 see	this	
window:	

	

	

	

	

	

	

	

	

	

	
Start	button	
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	 D.	Once	the	test	begins,	you	will	see	real-time	data	of	the	torque	the	participant	is	
	 generating,	as	well	as	progress	through	the	current	set	via	the	Pie	Chart.	

	 E.	During	rest	periods	between	sets	or	sections	of	a	protocol,	the	
	 window	to	the	right	will	count	down	to	the	next	set.		

	

	

7.	When	a	test	is	done,	you	can	click	on	the	Report	button	or	the	Curve	button	to	
view	results.	

A.	The	report	window	gives	options	for	generating	standard	reports.	This	is	
an	easy	way	to	give	participants	feedback	on	their	performance.	Here	you	
can	preview	a	report	or	print	a	report.	If	you	will	not	be		printing	a	report	and	
all	tests	are	complete,	the	testing	session	is	over.		
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B.	To	analyze	results	in	Biodex	Advantage	or	export	data	to	an	ASCII	format,	click	on	the	Curve	
button.	

i.	There	are	many	options	for	real-time	analysis	in	the	curve	window.	These	are	pointed	
out	below.	

	

	

	

	

	

	

	

	

	

ii.	Data	exported	from	the	Curve	window	can	be	taken	off	the	computer	on	a	USB	drive	
and	analyzed	using	other	software	(e.g.,	MatLab,	Excel).

	

	

	

Click	here	to	
export	data	

	

Enable	cursors	(blue	lines	
in	graph	above)	and	use	
buttons	here	to	select	
ranges	of	data	

	

Options	for	adjusting	
graph	display	and	
performing	some	real-time	
analysis.	We	do	not	
recommend	using	the	
“Filtered”	option	except	
for	demonstration	
purposes	

	

Change	
between	
tests	here	
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MANUAL	OF	PROCEDURES	
	

Human	Motion	Core	
	
	

Institute	of	Applied	Life	Sciences	

Life	Science	Laboratories	S360	
240	Thatcher	Road,	

Amherst,	MA	01003	

at	the		

University	of	Massachusetts,	Amherst	
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Chapter	1	
Qualisys	Oqus	700+/500+	w/	AMTI	Force	Platform	integration	

Chapter	1.1	-	Creating	a	New	Project	in	QTM	

	

When	beginning	a	new	study	you	will	need	to	create	a	new	project	in	QTM.	This	process	ensures	that	you	
don’t	inadvertently	alter	another	study’s	project	settings	and	also	creates	a	designated	directory	for	your	
study’s	data.	

	

1.	First,	open	QTM	

	

	

2.	A	window	displaying	current	projects	will	pop	up	when	you	open	QTM.	When	creating	a	new	project,	click	
“New	project…”	

	

	

3.	The	following	window	will	pop	up.	In	“Project	name:”	type	the	name	of	your	study	or	the	name	you	would	
like	to	be	applied	to	your	directory.	Note	that	when	you	change	this	name,	the	end	of	the	“Project	folder	
path:”	will	change.	If	you	would	like	the	project	folder	to	be	located	somewhere	other	than	where	is	
indicated	by	the	“Project	folder	path:”	you	can	browse	to	that	location	using	the	“Browse…”	button.	When	
your	name	and	path	are	set,	select	“Settings	imported	from	another	project”	and	hit	“OK.”	
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4.	Another	dialog	window	will	open	asking	you	to	select	a	“Settings”	file	to	base	your	new	project	on.	
Navigate	to	C:\Users\Qsys02\Documents\Project_Starter	and	select	the	“Settings”	file	found	there.	These	
project	settings	have	been	created	specifically	to	act	as	a	starting	point	for	new	projects.	

	

	

	

	

	

	

	

	

Type	your	desired	project	name	here	

Check	this	path	

	 Use	this	option	

	

	



Updated:	16	October	2017	 Room	Calorimeter	Core	 79	

5.	After	clicking	“Open,”	QTM	should	start	up.	Ensure	that	you	are	in	your	new	project	by	checking	the	top	
bar	on	the	QTM	window.	It	should	now	read	[Project:	Your	project	name]	

	

Additionally,	there	should	now	be	a	folder	at	the	path	you	previously	designated	that	has	the	following	
folders/files	in	it:	

	

	

6.	After	verifying	that	your	new	project	has	been	created	correctly,	you	can	begin	changing	settings.	To	do	

this,	first	click	on	the	project	options	 	button.	There	are	several	project	settings	that	you	may	wish	to	
change	(NOTE:	after	any	change	is	made,	you	must	hit	“Apply”).	This	section	in	this	manual	is	not	all-
encompassing;	for	further	details	see	the	online	Qualisys	user	manual	section	“Project	options”	by	clicking	
Help	>	Help	topics.	

	

Input	Devices.	Here	you	can	change	which	devices	you	will	be	collecting	with.	Oqus	cameras	cannot	be	
disabled,	but	in	this	setting	window	you	can	select	or	disable	forceplate	collection	(USB-2533)	and	EMG	
inputs	(MEGA,	Noraxon).	
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Marker	capture	frequency.	Change	this	number	to	adjust	how	many	frames	of	marker	data	are	collected	
per	second.	Capture	frequency	needed	depends	on	speed	of	movement	being	captured.	

	

	

Timing	options.	Use	these	settings	to	activate	an	external	trigger.	This	may	be	desired	if	you	are	
synchronizing	multiple	data	acquisition	softwares	(e.g.,	QTM	and	EMG	software)	or	if	you	wish	to	trigger	a	
data	capture	from	in	the	collection	space	instead	of	from	the	computer.	
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Camera	settings.	In	this	tab	you	can	adjust	capture	settings	for	individual	cameras.	Note	that	you	can	
adjust	settings	for	multiple	cameras	at	a	time	by	holding	Ctrl	while	clicking	on	camera	numbers	or	you	can	
adjust	each	camera	individually.	In	general,	camera	settings	should	not	need	to	be	changed.	Instances	
when	they	may	need	to	be	adjusted	include	the	use	of	a	device	in	the	capture	space	that	is	very	shiny	or	
very	small	or	very	large	markers.	If	you	wish	to	change	camera	settings	it	is	recommended	that	you	read	
the	Qualisys	help	topics.	
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Analog	settings.	Here	you	can	change	the	capture	rate	for	any	analog	devices	you	include	in	your	project.	
Sample	rates	must	be	a	multiple	of	the	camera	frame	rate	and	can	be	changed	in	the	box	outlined	below.	
There	are	also	settings	here	for	removing	offset	from	analog	data	(yellow	box).	Use	caution	if	activating	
these	options	as	the	software	offset	removal	assumes	that	there	is	nothing	on	the	forceplates	when	it	
removes	any	baseline	offset,	a	feature	that	may	be	problematic	if	someone	happens	to	cross	over	a	
forceplate	during	the	offset	removal.		
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3D	tracking.	Here	you	can	adjust	settings	for	error	tolerance	in	3D	marker	tracking.	

	 	 	

“Prediction	error”	is	the	maximum	distance	between	a	marker’s	predicted		 	
	 location	and	the	captured	location	of	the	marker.	If	the	captured	location	is		 	
	 outside	of	this	predicted	location,	the	software	will	not	reconstruct	it.	Increase	this		
	 value	to	increase	the	tolerance	in	reconstruction.	

“Maximum	residual”	is	the	maximum	deviation	in	camera	2D	views	of	a	marker	that	can	be	
converged	into	a	single	marker	trajectory.	Qualisys	recommends	that	this	value	be	2-5	times	the	
average	residual	values	from	the	calibration	results.	

	 “Minimum	trajectory	length”	is	the	minimum	number	of	frames	of	data	to		 	
	 create	a	trajectory.	Data	seen	for	fewer	frames	will	not	be	assigned	to	a	trajectory.		 	 The	
minimum	value	for	this	option	is	2.	

	

	 “Auto	join”	automatically	joins	trajectories	that	appear	to	belong	to	the	same		 	
	 marker	in	3D	space.	This	may	reduce	the	number	of	parts	in	a	trajectory	and	may		 	
	 make	tracking	easier.	This	does	not	automatically	fill	gaps.	

	

	

	 Trajectories.	Here	you	can	adjust	settings	for	automatically	filling	gaps.	
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	 Force	Data.	In	these	settings	you	can	select	which	force	plates	you’d	like	to	collect	with	and	check	
advanced	forceplate	options.	

	

	

	 GUI.	In	GUI,	2D	View	Settings,	and	3D	View	Settings	you	can	adjust	settings	such	as	the	real-time	
screen	refresh,	and	the	appearance	of	the	screen	in	2D	and	3D	modes.	

Miscellaneous.	Here	you	can	adjust	folder	settings	and	QTM	startup	settings.	Please	do		 not	adjust	
the	“Global	directories”	options	(in	Folder	Options)	or	the	“Automatically	load	a	project	at	startup”	
options	(in	Startup)	as	these	change	defaults	for	all	users.	

Project	options	are	automatically	saved	to	your	project	Settings	file	when	you	click	“Apply”	and	then	“OK.”	It	
is	recommended	that	you	always	pilot	data	collection,	processing,	and	analysis	using	your	new	project	
settings.	This	will	ensure	that	your	settings	are	sufficient	to	capture	the	information	you	need.		
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Chapter	1.2	

QTM	Data	Collection	

If	collecting	data	on	a	participant,	turning	the	system	on	and	calibration	steps	should	be	performed	before	the	
participant	arrives.	Cameras	and	forceplates	should	be	allowed	to	warm	up	for	at	least	20	minutes	before	
calibrating.	
Turning	things	on:	

1.	Turn	on	data	collection	computer.	

2.	Turn	on	power	strip	for	cameras	(located	on	tower	to	left	of	data	collection	computer)	

3.	Make	sure	forceplates	are	on	(3	boxes	directly	to	the	left	of	the	computer	monitors).	

	

	

4.	Find/add	new	participant	folder	to	project	folder	(C:\Users\Qsys02\	Documents\your	project	folder\Data).	

5.	Open	QTM	

	

	

Power	switch	

Manual	zeroing	
button	
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6.	Load	your	project	

	

7.	If	you	need	to	create	a	new	project,	follow	instructions	in	Chapter	X.X	
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Calibration:	

1.	Hit	the	“new”	button	 		(top	left	of	toolbar)	

2.	Click	on	2D	view,	check	camera	views	to	make	sure	each	camera	is	seeing	0	markers.	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

3.	Place	L	frame	on	forceplate	1	(end	small	FP)	with	the	long	arm	pointing	towards	the	big	forceplate.		Make	sure	it	
fits	tightly	to	the	forceplate	corner	(use	drop-down	legs),	aligns	with	the	forceplate	edges,	and	is	level.		If	the	levels	
are	off	the	tilt	of	the	L	can	be	adjusted	using	the	round	screws	on	the	arms.		Adjust	them	until	the	L	is	level	in	both	
planes.	
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4.	Put	the	calibration	wand	together.	Click	the	calibration	button	 .		

	

5.	Adjust	calibration	settings	as	preferred.	For	calibrating	a	volume	for	gait	(all	3	forceplates	+	space)	60	seconds	
may	be	necessary.	Using	a	calibration	delay	will	give	you	time	to	hit	“OK”	and	get	set	in	the	volume	before	the	start	
of	calibration	capture.	When	you	are	ready	to	calibrate,	hit	“OK.”	

6.	Calibrate	the	volume.	It’s	generally	recommended	to	do	this	in	a	systematic	method,	covering	the	entirety	of	the	
desired	capture	volume	with	the	calibration	wand	in	a	way	that	all	cameras	view	the	wand	over	the	full	volume	
(i.e.,	don’t	have	your	back	to	one	wall	of	cameras	throughout	the	entire	calibration).	
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7.	Calibration	will	end	when	the	set	time	has	elapsed.	This	window	will	pop	up:	

Standard	deviation	of	wand	length	should	be	less	than	1	mm.	If	this	criteria	is	met,	hit	“OK”	and	put	away	
calibration	equipment.	

	

	

	

8.	Calibration	will	occasionally	fail.	If	calibration	fails,	check	camera	2D	views	to	make	sure	no	markers	other	than	
the	L	and	the	calibration	wand	are	visible.	If	no	other	markers	or	reflections	are	visible,	start	calibration	over	again.	

Note:	cameras	will	pick	up	anything	reflective,	including	running	shoes	and	reflective	tags	on	clothing.	Make	sure	
you	do	not	have	anything	reflective	on	when	calibrating.	
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Data	Collection:	

1.	With	nothing	on	the	forceplates,	zero	forceplates	(orange	buttons	on	forceplate	boxes).	When	plates	are	zeroed,	
the	orange	lights	should	be	off.	

2.	Click	the	“capture”	button.	 	This	window	will	pop	up:	

	

3.	Adjust	the	Capture	Period	to	the	desired	length	of	time.	Changing	the	time	box	will	automatically	change	the	
number	of	marker	frames	box.	

4.	Check	the	“Save	captured	and	processed	measurement	automatically”	box.	Make	sure	folder	that	is	directed	to	is	
where	you	would	like	your	data	to	be	stored.	

5.	Change	the	“Name”	box	to	whatever	you	would	like	the	prefix	of	your	files	to	be.	If	you	would	like	files	to	be	
automatically	numbered	as	you	collect	them,	check	“Add	counter	starting…”	

6.	Click	“Options…”	to	check	Camera	System	Settings	to	make	sure	frame	rate	and	trigger	settings	are	correct.	
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7.	When	you	are	ready	to	collect	a	trial,	hit	“Start.”	

8.	At	the	end	of	the	capture	period,	the	trial	will	open	in	3D	view.	Play	through	the	trial	using	the	buttons	in	the	

toolbar:	 	

or	by	dragging	the	top	arrow	along	the	bottom	timebar:	

	

9.	Labeling	data	(to	create	an	AIM	model,	use	a	motion	trial,	not	a	static	trial):	

Scan	through	the	trial	to	make	sure	all	necessary	marker	and	force	data	were	captured.	Move	data	to	a	
timepoint	where	all	markers	are	visible	in	the	3D	view.	

	 To	label	data,	first	open	trajectory	windows	by	clicking	View	>	Trajectory	Info	>	All.	

	 	 Right-click	in	the	“Labeled	trajectories”	window	and	select	“Load	label	list…”		 	 	 	

Select	your	marker	list.	

	 If	you	have	not	previously	created	a	label	list,	right-click	on	the	word	“Trajectory”	and	select	“Add	new	
label.”	This	will	create	a	“New	####”	label.	

	 Add	as	many	labels	as	markers	in	your	markerset	and	name	them	appropriately.	

When	all	labels	are	created,	right-click	in	the	“Labeled	trajectories”	window	and	select	“Save	label	
list…”	

	 	 II.	To	begin	labeling	markers,	select	the	first	marker	in	the	label	list	and	click	the			

	 	button	(left	vertical	toolbar).	

	 	 III.	In	the	3D	view,	click	on	the	marker	corresponding	to	the	first	label.	In	ID		 	
	 mode,	the	program	will	progress	to	the	next	label	in	the	label	list	when	a	marker	is	clicked	on.		

	 	 IV.	Continue	clicking	on	the	markers	in	the	3D	view	that	correspond	to	the	label			
	 highlighted	in	the	label	list	until	you	reach	the	end	of	the	label	list.	

	 	 V.	Click	the	 	button	to	turn	off	ID	mode.	

	 	

	 C.	Trim	trial	so	that	only	labeled	data	are	included	using	the	side	arrows	of	the	timebar.		Only	labeled	data	
are	included	when	all	marker	fill	levels	are	at	100%	(in	labeled		trajectory	window).		

	 	

	 D.	Click	“Generate	AIM	model”	button	 	
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	 E.	Select	“Create	new	model”	in	the	window	that	pops	up	and	then	click	“Next.”	

	 	

	

	 F.	In	the	next	window,	verify	that	the	model	looks	correct,	and	then	click	“Next.”	

	 G.	Enter	a	filename	for	your	AIM	model	and	click	“OK.”	In	the	final	window,	click	“Finish.”	

10.	To	have	AIM	applied	as	you	collect	data,	in	Project	Options	,	go	to	AIM	and	add	the	model	you	just	created	to	
the	“Applied	models:”	window.	Hit	“Apply,”	then	“OK.”	

11.	Continue	collecting	trials	until	finished.	

12.	If	you	wish	to	overwrite	a	trial,	set	the	Name	and	counter	to	match	the	trial	you	wish	to	overwrite.	When	you	
hit	“Start,”	a	window	will	pop	up	asking	if	you	wish	to	overwrite	the	trial.	Data	will	begin	collecting	when	you	hit	
“Yes.”	

13.	When	data	collection	is	completed,	turn	off	cameras	and	copy	data	to	appropriate	location	(e.g.,	external	hard	
drive,	network	folder,	etc.).	 	
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Chapter	1.3	-	QTM	Data	Processing	

	

Data	Processing	in	QTM	

After	data	are	collected,	they	must	be	tracked	and	exported	from	QTM	for	further	analysis.	

Tracking	marker	data	

1.	Navigate	to	location	of	motion	capture	data	on	the	computer.	QTM	files	end	in	*.qtm	and	can	be	opened	
on	a	computer	with	QTM	software	either	by	double-clicking	on	the	file	from	Windows	Explorer	or	using	the	

“Open	file”	 	button	in	QTM.	

	

2.	Before	tracking	your	data,	you	may	wish	to	trim	the	trial	to	only	the	range	of	frames	of	interest.	For	
example,	you	may	wish	to	do	this	if	you	want	a	single	stride	of	data	from	a	trial	which	includes	data	of	your	
participant	walking	all	the	way	across	the	data	capture	space.	

	 A.	To	shorten	a	trial,	click	and	drag	the	arrow	buttons	on	either	end	of	the	timebar.	

	

	

	 B.	For	example,	here	I	have	trimmed	off	the	beginning	and	end	of	a	trial	of	data.	

	

	

	 C.	Once	you	trim	a	trial,	marker	information	will	only	be	displayed	for	the	frames	inside		 the	timebar	
arrows.	Note	that	this	range	can	always	be	changed	later	on	if	you	decide	you		 want	to	track	more	
of	your	trial.	

3.	If	markers	are	already	labeled,	skip	to	step	5.	
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4.	If	markers	are	not	yet	labeled,	a	label	list	will	need	to	be	created.	Un-labeled	markers	appear	red	and	all	
trajectories	will	be	listed	in	the	“unidentified	trajectories”	box.	If	you	don’t	see	the	trajectory	boxes,	click	
View	>	Trajectory	Info	>	All	to	open	these	boxes.	

	

	

	 	 A.	Right-click	in	the	“Labeled	trajectories”	window	and	select	“Load	label	list…”		 	
	 Select	your	marker	list.	

	 	 	 I.	If	you	have	not	previously	created	a	label	list,	right-click	and	select		 	 	
	 	 “Add	new	label.”	This	will	create	a	“New	####”	label.	

	 	 	 II.	Add	as	many	labels	as	markers	in	your	markerset	and	name	them		 	 	
	 	 appropriately.	

	 	 	 III.	When	all	labels	are	created,	right-click	in	the	“Labeled	trajectories”		 	 	
	 	 window	and	select	“Save	label	list…”	
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	 	 B.	To	begin	labeling	markers,	select	the	first	marker	in	the	label	list	and	click	the			 	

	 	button.	

	 	 C.	In	the	3D	view,	click	on	the	marker	corresponding	to	the	first	label.	In	ID		 	 	
	 mode,	the	program	will	progress	to	the	next	label	in	the	label	list	when	a	marker	is		 	
	 clicked	on.		

	 	 D.	Continue	clicking	on	the	markers	in	the	3D	view	that	correspond	to	the	label		 	 	
	 highlighted	in	the	label	list	until	you	reach	the	end	of	the	label	list.	

	 	 E.	Click	the	 	button	to	turn	off	ID	mode.	

	 	 F.	Trim	trial	so	that	only	labeled	data	are	included	using	the	bottom	arrow	of	the	timebar:	

	 	 	

	 	 G.	Click	“Generate	AIM	model”	button	 	

	 	 E.	Select	“Create	new	model”	in	the	window	that	pops	up	and	then	click	“Next.”	

	 	 	

	 	 F.	In	the	next	window,	verify	that	the	model	looks	correct,	and	then	click	“Next.”	

	 G.	Enter	a	filename	for	your	AIM	model	and	click	“OK.”	In	the	final	window,	click			 “Finish.”	

	 H.	After	creating	an	AIM	model,	the	model	can	be	applied	to	new,	unlabeled	files	of	the		same	

participant/data	collection	session	using	the	 	button.	
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5.	If	markers	are	already	labeled,	the	next	step	is	to	clean-up	the	data.	Generally,	the	goal	of	cleaning-up	the	
data	is	to	make	sure	there	are	no	gaps	in	marker	data.	

	

	

Note:	it	is	rare	that	there	are	
no	markers	in	“Unidentified	
trajectories,”	even	when	all	
markers	are	labeled.	
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6.	First,	check	that	all	markers	are	correctly	labeled	(e.g.,	the	Right	ASIS	is	actually	labeled	as	RASI	rather	than	
as	RSHF	or	something	else).	To	check	this,	you	can	click	on	a	marker	in	the	“Labeled	trajectories”	box	and	it	
will	be	highlighted	in	the	3D	view	(and	vice	versa).	Also	note	that	label	colors	in	the	“Labeled	trajectories”	box	
match	the	color	of	the	markers	in	the	3D	view.	

	

	

	 A.	The	“Fill	Level”	column	for	each	marker	tells	you	what	percent	of	the	trial	contains	data	and	a	label	
for	this	marker.	The	“Range”	column	tells	you	during	which	frames	the	labeled	marker	appears.	At	
the	end	of	data	tracking	marker	data	you	want	all	markers	of	interest	to	be	at	100%	for	the	range	of	
frames	of	interest.	

	 	

	 B.	The	+	sign	next	to	a	marker	indicates	that	this	marker	trajectory	is	made	up	of	multiple	
	 parts.	If	you	expand	by	clicking	on	the	+	sign,	you	can	see	how	many	parts	are	in	a	given		trajectory	
and	what	frames	they	appear	during.	
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7.	When	you	have	confirmed	that	all	markers	are	labeled	correctly,	you	can	begin	fixing	gaps	in	data.	There	
are	2	general	methods	for	fixing	gaps	in	data	which	are	detailed	below.	

	 A.	Option	1:	filling	a	gap	in	a	marker	trajectory	when	there	is	an	unlabeled	trajectory		 available	
(best	option	if	available)	

	 	 I.	Sometimes	QTM	does	not	do	a	perfect	job	of	identifying	which	marker	is		 	
	 which,	even	after	you	label	data.	This	will	result	in	sections	of	data	where	there	is		
	 a	marker	in	the	3D	view	but	it	is	unlabeled	(or	in	some	cases,	is	labeled		 	 	
	 incorrectly).	Below,	we	see	that	the	Left	PSIS	(LPSI)	is	labeled	for	90%	of	the		 	
	 trial,	except	for	the	frame	range	1960-2559.	There	is	an	unidentified		 	 	
	 trajectory	that	coincides	with	most	of	this	frame	range.	

	

	 	 II.	To	add	this	unidentified	trajectory	to	the	LPSI,	click	and	hold	on	either	the		 	
	 unidentified	marker	in	the	3D	view	or	the	Unidentified	trajectory	in	the		 	 	
	 “Unidentified	trajectories”	box,	and	drag	it	to	LPSI	in	the	“Labeled	trajectories”		 	
	 box.
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	 	 III.	Now	the	unidentified	trajectory	has	been	added	to	LPSI.	

	 	 	

	 	 IV.	Sometimes	the	unidentified	trajectory	you	are	trying	to	add	to	fill	a	gap	in	a		 	
	 labeled	marker	overlaps	with	existing	data	and	you	will	get	the	following		 	
	 message:	

	 	 	

	

	 	 	 a.	If	you	hit	“OK,”	a	box	showing	3D	trajectories	will	pop	up	in	which		 	
	 	 you	can	select	the	range	of	the	unidentified	marker	you’d	like	to	keep.		 	
	 	 This	tool	can	be	unwieldy	and	difficult	to	use	at	times.	

	

	 	 	 b.	If	you	hit	“Cancel,”	you	can	instead	manually	identify	the	overlapping			
	 	 data.	
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c.	In	the	example	below,	you	can	see	that	the	unidentified	trajectory	contains	2	parts	
of	data	which	cover	the	range	1961-2558.	LPSI	already	has	data	for	frames	2553-
2559.	To	determine	which	data	to	keep	(the	data	already	in	LPSI	for	these	frames	or	
the	data	from	the	unidentified	trajectory	for	these	frames),	navigate	to	this	frame	
range	in	the	3D	view	using	the	timebar	at	the	bottom	of	the	screen.	 	
	
	

	

	 	 	 d.	During	the	overlapping	frames,	you	should	be	able	to	see	two	markers.		
	 	 These	may	overlap	very	closely	in	space	(as	shown	below)	or	they	may		 	
	 	 not.	

	 	 	 	

	

e.	At	this	point	you	need	to	choose	which	data	you	want	to	keep.	If	you	wish	to	keep	
sections	of	one	marker	which	go	before	and	after	another	(in	this	case,	say	we	want	
to	take	the	unidentified	marker	for	the	range	before	and	after	the	overlapping	LPSI	
data),	you	may	need	to	split	one	trajectory.	To	do	this,	navigate	to	the	last	time	point	
you’d	like	to	keep	of	the	trajectory	of	interest,	right-click	on	the	trajectory	in	the	
“Labeled	trajectories”	or	“Unidentified	trajectories”	box,	and	click	“Split	part	after	
current	frame.”	This	will	cut	the	selected	trajectory	into	2	parts.	You	may	need	to	do	
this	again	at	the	end	of	the	range	of	interest.	Then	the	split	part	or	parts	can	be	
dragged	and	added	to	the	labeled	trajectory.	

	 B.	Option	2:	gap-filling	a	gap	in	a	marker	when	there	is	no	unidentified	trajectory	to	swap	in	

	 I.	Below,	we	see	an	example	of	a	frame	of	data	where	there	is	no	LPSI,	and	no	
unlabeled	trajectory	to	swap	into	its	place.	In	cases	like	this,	you	have	to	perform	a	
gap	fill.	
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	 	 II.	To	gap	fill	data,	select	the	Parts	on	either	side	of	the	gap	(below,	there	are	data		
	 from	1-1959	and	1961-2552,	but	no	data	for	frame	1960),	right-click,	and	select			
	 “Gap	fill	trajectory	with	preview”	
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III.	A	window	displaying	the	3D	trajectory	of	the	selected	marker	will	pop	up	and	show	how	
the	gap	is	to	be	filled.	Following	the	instructions	in	the	bottom	of	this	window,	you	can	zoom	
in	on	the	gap	and	adjust	the	range	of	frames	you	want	the	gap	fill	to	span.	Note	that	gap	fills	
must	begin	and	end	at	labeled	marker	data	as	the	fill	is	constructed	using	a	polynomial	fit	
based	on	existing	data.	

	

	

	

Gap	range	in	trajectories	(X,	Y,	and	Z)	

Range	of	gap	being	shown	
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	 	 IV.	General	guidelines	for	gap	filling	data:	

	 	 	 a.	Use	caution	when	filling	larger	gaps	(range	depends	on	frequency	of		 	
	 	 data	capture,	speed	of	movement,	etc.).	Gap	filled	data	is	not	real	data	and		
	 	 large	gap	fills	may	be	a	distorted	representation	of	the	true	motion	of	a			
	 	 marker.	

	 b.	Adjust	gap	fill	frames	so	that	there	are	not	abrupt	shifts/discontinuities	in	the	3D	
trajectories.	Often	times	before	a	marker	drops	out	and	creates	a	gap,	the	cameras	
are	having	difficulty	calculating	its	position	and	so	the	last/first	frame	or	two	of	
existing	data	will	be	shifted.	

	 c.	For	any	gap	fill	larger	than	a	few	frames,	always	view	the	3D	representation	of	the	
gap	fill	by	playing	through	the	corresponding	frames	while	watching	the	3D	view	of	
your	data	to	check	for	visible	errors	in	the	gap	filled	data.	

8.	When	all	markers	are	labeled	at	100%,	data	tracking	is	complete.	

9.	After	data	tracking,	data	must	be	exported	from	QTM	for	further	processing.	Files	can	be	exported	in	the	
following	formats:	

-C3D:	Visual	3D	file	format	

-TSV:	tab-delimited	data	that	can	be	viewed	in	excel	and	read	into	a	variety	of		 programs	

-MAT:	MatLab	file	format	

-AVI:	video	file	of	marker	data	

	 A.	Files	can	be	exported	one-at-a-time	or	in	bulk.	

	 	 I.	To	export	files	in	bulk,	click	File	>	Batch	Process		

	 	 	 a.	When	using	Batch	Process,	the	first	window	to	pop	up	asks	you	to		 	
	 	 select	the	desired	files.	After	selecting	the	desired	files	and	clicking		 	
	 	 “Open,”	a	window	similar	to	the	one	below	will	pop	up.	
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b.	In	the	“Processing”	tab	(shown	below),	you	can	select	which	file	format	you	want	
to	export	to	and	also	set	additional	processing	options.	If	you	want	to	export	the	data	
in	the	form	that	you	currently	have	(e.g.,	markers	tracked,	trials	trimmed,	etc.),	DO	
NOT	select	any	options	except	for	your	exporting	file	format.	Other	options	may	
undo	work	that	you	have	already	done	(e.g.,	selecting	“Track	the	measurement”	will	
re-track	all	files	in	raw,	unlabeled	format).	

	

	

	 c.	In	the	secondary	Batch	Processing	tab	(above,	this	would	be	the	“C3D		Export”	tab	
on	the	top	left),	you	can	select	options	specific	to	that	file	format.	 	

	 	 II.	To	export	files	one-at-a-time,	click	File	>	Export	>	[desired	file	type].	Using		 	
	 this	dialog,	only	the	secondary	window	options	described	above	in	C	will	pop	up.	

10.	After	exporting	data,	processing	in	QTM	is	complete	



Updated:	16	October	2017	 Room	Calorimeter	Core	 105	

	
Chapter	1.4	-		Example	Marker	Sets	

	
The	Human	Motion	Core	has	some	standard	markersets	that	may	be	used	for	motion	capture	of	

certain	tasks.	These	markersets	include	full-body,	right	lower	extremity,	left	lower	extremity,	and	head	with	
Frankfort	plane.	Users	can	feel	free	to	copy	these	markersets	and	modify	as	needed.	In	general,	the	full	body	
and	lower	extremity	marker	sets	are	optimized	for	calculation	of	lower	extremity	joint	mechanics.	A	more	
detailed	markerset	than	the	full	body	markerset	would	be	needed	to	calculate	upper	extremity	mechanics,	
but	the	current	markerset	can	be	used	to	account	for	segment	sizes/masses	for	center-of-mass	calculations.	

Below	are	images	of	the	standard	markersets	with	markers	labeled.	At	the	end	of	this	document	is	a	
definition	of	the	marker	labels.	Note	that	in	the	standard	markersets,	marker	labels	are	consistent	from	
markerset	to	markerset.	
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Unilateral	Lower	Extremity	
This	markerset	exists	in	a	right	side	and	left	side	version.	The	right	side	is	shown	below.	There	are	some	
differences	in	the	markers	on	the	lower	extremity	between	this	model	and	the	full-body	model.	This	model	
has	a	foot	markerset	that	can	be	used	to	calculate	whole	foot	and	rearfoot	angles.	Additionally,	this	model	
has	different	pelvic	markers	compared	to	the	whole	body	model	which	will	lead	to	difference	pelvic	segment	
definitions	but	no	substantial	differences	in	segment	motion	calculations.	

	

	

	

	

	

	

	

	

	

	

	

	

	

RASI LASI 

LGRT RGRT 

LPSI RPSI 

RMCO RLCO 

RMMA RLMA 

R1MH R5MH 

RTOE 

RTHF 
RTHU 

RTHL 
RTHR 

RSHF RSHU 

RSHL RSHR 

RHLA 

RHPR RTOE 

 

RPSI 
RASI 

RGRT 

RHPR 

RHLA RHMD 

RMMA 
RLMA 

R5MH 

RTOE 

Frontal	view	of	unilateral	markerset	

Close	up	of	rearfoot	of	unilateral	markerset	

Posterior	view	of	unilateral	markerset	
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RASI LASI 
LILC RILC 

SLJ 

RACJ LACJ 

LLCO 
LMCO 

RMCO 
RLCO 

RMMA RLMA LLMA LMMA 

L5MH L1MH 
LTOE RTOE 

R1MH R5MH 

FLH FRH 

BRH BLH 

TOPH 

LELB RELB 

RDUL 

RDRA 
LDRA 

LDUL 
LBTH 

LHAN 

LFIN 
RFIN 

RHAN 

RBTH 

Full	Body	

This	markerset	includes	the	same	general	lower	extremity	model	as	the	lower	extremity	markersets,	but	adds	
a	trunk,	arms,	and	a	head.	Note	that	this	markerset	does	not	include	the	3-marker	rearfoot.	This	can	be	easily	
added	as	shown	in	the	lower-extremity	image.	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

	

Frontal	view	of	full	body	markerset	
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View	of	right/front	side	of	full-body	markerset	

	

	

	

	

LTHF 

LTHL 

LTHU 

LTHR 

RTHF 

RTHL 

RTHU 

RTHR 

LSHF 

LSHL 

LSHU 

LSHR RSHF 

RSHL 

RSHU 

RSHR 
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Posterior	View	of	full-body	markerset	

	 	

RARF 
RARU 

RARL 
RARR 

RFAF 

RFAL 
RFAU 

RFAR LFAR 
LFAL 
LFAF 

LARU 

LFAU 

LARF 

LARR 
LARL 

BLH 

RACJ 

SLJ 

RHEEL 
LHEEL 

LACJ 

BRH 

TOPH 



Updated:	16	October	2017	 Room	Calorimeter	Core	 110	

	

	

	

	

	

	

	

	
Head	Markerset	for	Gaze	Tracking	

	

FLH FRH 

BRH BLH 

TOPH 

LAUM 

RZYA LZYA 

RAUM LAUM 
RZYA 

LZYA 

RAUM 

TOPH 

BLH FLH 

FRH 
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Marker	name	definitions	
Marker	labels	are	listed	by	segment	

	
Head:	
Crown/helmet	
TOPH	–	top	of	head	
FRH	–	front	right	of	head	
BRH	–	back	right	of	head	
FLH	–	front	left	of	head	
BLH	–	back	left	of	head	
	
Frankfort	plane	
R/L	AUM	–	right/left	auditory	meatus	
R/L	ZYA	–	right/left	zygomatic	arch	
	
Trunk:	
R/L	ACJ	–	right/left	acromioclavicular	joint	
Upper	Back	Trunk	Cluster	
Lower	Back	Cluster	(if	you	want	both	lumbar	&	thoracic	spine)	
	
Arm:	
Upper	arm	rigid	cluster	
R/L	ARU	–	right/left	arm	upper	
R/L	ARF	–	right/left	arm	front	
R/L	ARL	–	right/left	arm	lower	
F/L	ARR	–	right/left	arm	rear	
	
Forearm	rigid	cluster	
R/L	FAU	–	right/left	forearm	upper	
R/L	FAF	–	right/left	forearm	front	
R/L	FAL	–	right/left	forearm	lower	
F/L	FAR	–	right/left	forearm	rear	
	
R/L	DRA	–	right/left	distal	radius	(radial	styloid)	
R/L	DUL	–	right/left	distal	ulna	(ulnar	styloid)	
R/L	HAN	–	right/left	hand	
R/L	BTH	–	right/left	base	of	thumb	
R/L	FIN	–	right/left	second	finger	
	
	
	
Pelvis:	
R/L	ASI	–	right/left	anterior	superior	iliac	spine	(ASIS)	
R/L	ILC	–	right/left	iliac	crest	
R/L	PSI	–	right/left	posterior	superior	iliac	spine	(PSIS)	
SLJ	–	sacrolumbar	joint	
R/L	GRT	–	right/left	greater	trochanter	
	
Lower	extremity:	
Thigh	rigid	cluster	
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R/L	THU	–	right/left	thigh	upper	
R/L	THF	–	right/left	thigh	front	
R/L	THL	–	right/left	thigh	lower	
R/L	THR	–	right/left	thigh	rear	
	
Shank	rigid	cluster	
R/L	SHU	–	right/left	shank	upper	
R/L	SHF	–	right/left	shank	front	
R/L	SHL	–	right/left	shank	lower	
R/L	SHR	–	right/left	shank	rear	
	
R/L	LCO	–	right/left	lateral	femoral	epicondyle	
R/L	MCO	–	right/left	medial	femoral	epicondyle	
R/L	LMA	–	right/left	lateral	malleolus	
R/L	MMA	–	right/left	medial	malleolus	
	
R/L	1MH	–	right/left	first	metatarsal	phalangeal	joint	
R/L	5MH	–	right/left	fifth	metatarsal	phalangeal	joint	
R/L	TOE	–	right/left	toe	
R/L	HEEL	–	right/left	heel	
R/L	HPR	–	right/left	heel	proximal	
R/L	HMD	–	right/left	heel	medial	
R/L	HLA	–	right/left	heel	lateral	
	

Calibration	Markers	
Both	Calibration	&	Tracking	Markers	
Tracking	Markers	
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CHAPTER	1.5	-	Visual	3D	Tutorial	

Visual3D	(V3D)	is	a	motion	capture	analysis	software	package	that	can	make	data	analysis	relatively	
straightforward	and	streamlined.	C-Motion,	the	developers	of	V3D,	have	created	a	high-quality	set	of	
documentation	for	this	software	(https://www.c-motion.com/v3dwiki/index.php/Visual3D_Overview).	If	you	
are	a	first-time	user	of	V3D	it	is	highly	recommended	that	you	go	through	the	V3D	tutorials	(https://www.c-
motion.com/v3dwiki/index.php/Visual3D_Tutorials)	to	fully	appreciate	the	tools	included	in	this	program,	as	
well	as	the	implications	of	incorrectly	modeling/computing	your	results.	

	

I.	V3D	Basics	

1.	V3D	works	with	motion	files	that	are	in	.c3d	format.	Motion	capture	data	can	be	exported	from	QTM	in	
this	format	which	will	include	any	marker,	analog,	and	force	data	captured	in	a	trial.	NOTE:	V3D	cannot	work	
with	files/commands/tags	that	have	spaces	in	the	name.	Never	use	spaces	in	file	names,	marker	names,	etc.	

2.	To	load	raw	data	files	in	V3D,	click	the	open	button	 	and	select	the	c3d	files	you	wish	to	view.	When	
files	are	loaded,	they	will	appear	in	the	“Workspace”	tab	in	V3D.	
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3.	To	view	these	data	files,	switch	to	the	“Signals	and	Events”	tab.	Here	you	can	select	which	file	to	view	using	
the	drop-down	menu,	play	or	scroll	through	a	trial	using	the	tools	at	the	bottom,	or	view	raw	TARGET	
(marker),	ANALOG,	or	FORCE	data.	

	

	

	

Drop-down	box	to	view	trials	

Playback	controls	

ORIGINAL	
(raw)	target	
data	

	

3D	data	view	
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4.	If	you	left-click	on	any	data	item,	a	Data	View	window	will	pop	up	to	show	you	trajectories	and	values	for	
that	data	item.	You	can	also	right-click	on	a	data	item	to	plot	it.	

	

	

5.	Viewing	raw	data	has	limited	utility.	Generally	you	will	want	to	build	a	model	and	apply	this	model	your	
data	trials.		

	

II.	Models	in	V3D	

Models	in	V3D	are	the	base	files	from	which	skeleton/segment	characteristics	are	applied	to	motion	
files.	In	order	to	create	a	model	to	apply	to	your	motion	files,	you	must	have	a	static	calibration	trial.	For	
human	motion,	especially	gait,	the	static	trial	is	generally	captured	while	an	individual	stands	still	in	anatomic	
position.	These	instructions	will	take	you	through	some	general	steps	for	creating	a	model	from	a	static	trial.	
This	is	not	the	only	way	to	create	a	model;	further	instructions	can	be	found	on	the	V3D	wiki.	

There	are	demo	V3D	files	that	you	can	use	to	explore	the	following	instructions.	A	completed	analysis	
can	be	viewed	by	opening	R_LE_walk.cmo.	The	files	used	to	build	this	analysis	include	one	static	trial	
(R_LE_static.c3d),	two	treadmill	walking	trials	(R_LE_walk01.c3d	and	R_LE_walk02.c3d)	a	model	file	
(R_LE_model.mdh),	and	a	pipeline	(R_LE_walk_pipeline.v3s).	These	files	are	for	demonstration	only	and	can	
be	used	to	explore	some	capabilities	of	V3D	but	are	not	inclusive	of	all	tasks	that	V3D	is	capable	of.	

There	are	some	pre-created	models	available	for	general	use.	These	include	unilateral	lower	
extremity	models	for	both	the	right	and	left	limbs	and	a	full-body	model.	These	models	are	based	on	the	
markersets	that	are	also	available	for	general	use	and	can	be	used	and	modified	as	needed.	These	models	are	
not	meant	to	be	all-inclusive	but	rather	provide	examples	and	starting	points	for	development	of	project-
specific	models.	Note	especially	that	the	upper	extremities	in	the	full	body	model	do	not	follow	ISB	

X,	Y,	Z	trajectory		

Data	residual	

Data	identity	
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recommendations	for	the	shoulder,	elbow,	or	forearm.	Users	should	always	review	the	V3D	wiki	
recommendations	for	modeling	of	segments	and	joints	above	the	pelvis.	

	

General	facts	about	models	

Models	in	V3D	consist	of	definitions	of	segments	and	landmarks	used	to	create	these	segments.	
These	definitions	are	needed	so	that	the	3D	orientation	of	segments	can	be	tracked	during	a	movement.	In	
general,	segments	are	defined	using	real	or	virtually-defined	markers	at	the	proximal	and	distal	ends,	as	well	
as	radii	of	the	proximal	and	distal	ends.	At	least	three	markers	are	needed	to	define	the	orientation	of	a	
segment.	When	a	segment	is	created,	it	is	assigned	a	coordinate	system	(see	red,	green,	and	blue	orthogonal	
axes	in	image	below)	which	is	rigidly	associated	with	the	segment’s	proximal	joint	(e.g.,	the	thigh	coordinate	
system	will	be	anchored	at	the	hip	joint).	Models	must	also	include	assignment	of	tracking	markers,	or	
markers	that	are	registered	to	the	segment	definition	in	a	calibration	trial	and	are	then	used	to	track	the	
movement	of	the	segment	during	movement	trials.	The	segment	coordinate	system	is	modeled	as	rigidly	
related	to	the	orientation	of	the	tracking	markers	and	for	this	reason	tracking	markers	are	often	placed	on	
plastic	shells	(e.g.,	thigh	and	shank	clusters)	or	on	anatomical	locations	with	little	skin	motion	artifact	(e.g.,	
acromio-clavicular	joints	during	lower	extremity	tasks).	In	addition	to	segment-specific	definitions,	models	
require	an	individual’s	height	and	body	mass	for	calculation	of	segment	inertial	properties	and	joint	kinetics.	

The	orientation	of	adjacent	segment	coordinate	systems	with	respect	to	each	other	provides	the	joint	
angle	or	joint	translational	position.	For	this	reason,	it	is	important	to	pay	attention	to	the	orientation	of	
segment	coordinate	systems	as	they	are	created.	In	the	image	below,	you	can	see	that	all	visible	segments	
have	the	red	(X)	axis	oriented	to	the	model’s	left.	This	matching	orientation	provides	ease	of	understanding	
for	joint	definitions.	For	example,	rotations	about	X	between	the	shank	and	thigh	are	sagittal	plane	joint	
angles,	those	about	Y	are	frontal	plane	joint	angles,	and	those	about	Z	are	transverse	plane	joint	angles.	In	
order	to	obtain	accurate	and	meaningful	data,	it	is	critical	that	you	correctly	define	and	construct	your	model.	
Recommendations	for	modeling	segments	and	joints	of	interest	can	be	found	on	the	V3D	wiki,	as	well	as	in	
published	recommendations	from	the	International	Society	of	Biomechanics.	

	

Applying	an	existing	model	to	movement	trials	

In	a	new	V3D	workspace	or	window,	on	the	menu,	click	“Model,”	then	“Create	(Add	Static	Calibration	Trial),”	
and	“Hybrid	Model	from	C3DFile.”	

A.	In	the	window	that	pops	up,	select	your	static	calibration	trial.	

	 B.	V3D	will	automatically	switch	to	the	“Models”	tab.	

	 C.	Click	the	Load	Model	Template	button	 	

	 	 i.	Select	the	model	file	(*.mdh)	you	would	like	to	use.	

	 	 ii.	The	model	should	now	be	applied	to	your	static	trial.	
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iii.	In	some	cases,	there	will	be	errors	in	building	the	model.	These	will	be	detailed	in	a	“Build	
Model	Results”	window.	
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	 	 iv.	If	this	occurs,	you	can	scroll	through	the	errors	and/or	warnings	to	determine		
	 	 what	issues	are	present.	Fixing	these	issues	may	involve	finding	a	correct,		 	
	 	 complete	static	trial,	correcting	the	names	of	markers,	or	modifying	the	model	to		
	 	 correspond	to	different	segment/landmark	definitions.	

D.	Definitions	of	how	model	segments	and	landmarks	are	created	can	be	found	by	double-clicking	on	
a	segment	or	landmark	in	the	left-hand	window	in	the	Models	tab.	
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i.	For	example,	if	you	look	at	the	right	thigh	in	this	model,	you	will	see	the	following	
definitions.	

	

	

ii.	Note	that	some	of	the	markers	used	for	defining	the	proximal	and	distal	joints	are	real	
markers	that	were	placed	on	an	individual	(e.g.,	RLCO,	RMCO)	while	other	markers	are	
“landmarks,”	or	virtual	markers	created	in	V3D	based	on	the	position	of	other	markers.	Here,	
the	F_RHIP	is	a	landmark.	
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iii.	If	we	look	at	F_RHIP	in	the	“Landmarks”	tab,	we	can	see	how	this	landmark	was	created.	
This	landmark	is	a	hip	joint	center	definition	based	on	literature	regression	equations.	

	

	

E.	After	applying	your	model,	the	workspace	should	look	something	like	this:	
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F.	Now	you	must	add	motion	files.	To	do	this,	click	the	open	button	 	and	select		 your	motion	
trials.	A	warning	window	will	pop	up,	select	“Insert	new	files	into	your		 currently	open	workspace.”	

	 	

	 	 i.	After	selecting	your	motion	trials,	your	workspace	will	look	something	like	this:	

	

	

G.	You	can	now	apply	your	model	to	your	motion	files.	To	do	this,	click	Model	>	Assign		 Model	to	
Motion	Files.	Select	the	trials	which	you	would	like	to	apply	the	model	to	
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	 	 i.	Now	your	workspace	should	show	your	motion	files	within	their	assigned		 	
	 	 model.	

	

	

	 	 ii.	If	you	view	your	motion	trials	in	the	“Signals	and	Events”	tab,	you	will	see	the			
	 	 model	applied	to	the	trials	(assuming	your	data	were	tracked	correctly	with		 	
	 	 marker	names	the	model	expected.)	Note	that	the	model	is	not	necessarily	to	scale		
	 	 or	completely	correct	anatomically	(e.g.,	model	femoral	heads	are	often	not	in	the		
	 	 acetabulum),	the	model	is	meant	as	a	visual	aid.	

	

	 	 iii.	If	a	segment	is	missing	or	incorrectly	oriented	in	a	motion	trial	it	is	due	to		 	
	 	 incorrectly	labeled	data.	Check	that	all	tracking	markers	are	present	in	the	motion		
	 	 trial	and	that	the	marker	names	assigned	to	the	motion	trial	match	those	in	the			
	 	 model.	

	



Updated:	16	October	2017	 Room	Calorimeter	Core	 123	

III.	Data	Analysis	and	Pipelines	

Once	you	have	data	loaded	into	V3D	and	a	model	assigned	to	your	motion	files,	you	can	process	your	signals,	
create	motion	events,	and	compute	outcomes	(e.g.,	joint	kinematics	and	kinetics).	This	can	be	done	using	
some	point-and-click	steps	but	is	more	efficiently	implemented	using	pipelines.	Pipelines	consist	of	a	series	of	
commands	which	can	be	saved	and	used	for	multiple	participants/conditions/iterations	in	a	study	and	thus	
assist	with	batch	processing	and	calculation	consistency.	The	following	instructions	will	go	through	some	
basic	pipeline	commands	that	may	be	used	during	any	analysis.	As	you	work	through	pipeline	commands	it	
will	become	clear	that	there	are	many	tools	available	in	pipelines.	Further	information	about	each	command	
can	be	found	in	the	V3D	wiki	documentation.	For	an	example	pipeline,	in	the	CPHM	demonstration	data	
provided,	the	analysis	of	the	R_LE_walk.cmo	file	was	performed	using	the	R_LE_walk_pipeline.v3s	file.	

1.	To	use	the	pipeline	tool,	click	on	the	pipeline	button.	 	The	following	window	will	pop	up.	

	

	

2.	In	the	left	hand	pane	of	this	window	are	all	available	commands,	organized	into	subgroups.	The	center	
pane	shows	commands	in	the	current	pipeline,	and	the	right	hand	pane	shows	a	preview	of	a	command	in	
the	current	pipeline	when	it	is	selected.	For	example,	if	you	were	to	start	creating	a	pipeline	with	a	command	
to	create	a	model	from	a	static	trial,	the	window	would	look	like	this:	



Updated:	16	October	2017	 Room	Calorimeter	Core	 124	

	

	

3.	When	you	have	a	command	in	a	current	pipeline	highlighted,	the	initial	text	of	that	command	as	well	as	a	
description	of	the	command	will	appear	in	the	right	hand	pane.	To	edit	the	command,	double-click	on	the	
command	in	the	middle	pane.	For	the	“Create_Hybrid_Model”	command,	double-clicking	on	the	command	
will	bring	up	a	window	of	text	that	can	be	edited.	In	these	types	of	windows,	“!”	indicates	that	the	pipeline	
should	skip	this	line	of	code	or	use	the	default	value.	In	the	window	below,	this	means	that	there	is	no	
specific	file	that	the	pipeline	is	pulling,	it	will	instead	open	a	dialog	window	asking	the	user	to	“Open	standing	
file.”	If	there	is	a	specific	file	you’d	like	to	load	using	this	command,	the	path	to	this	file	can	be	entered	in	the	
“/CALIBRATION_FILE=”	line	and	the	“!”	can	be	removed	from	this	line.	

Text	of	command	

Description	of	
command	
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4.	In	some	cases,	there	are	two	different	formats	in	which	to	edit	a	command.	For	example	when	you	double-
click	on	the	“Event_Copy”	command,	it	opens	a	GUI-type	window.	If	you	prefer	to	edit	the	command	in	text	

format,	you	can	click	on	the	command	in	the	middle	pane	of	the	pipeline	window	and	click	the	 	button.	
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5.	When	a	pipeline	is	created	and	saved,	the	.v3s	file	can	be	opened	as	a	text	document	for	ease	of	batch	
editing	(e.g.,	changing	export	file	names	on	a	subject-by-subject	basis).	

6.	Pipeline	window	buttons:	

	 A.	“Open	Pipeline…”	allows	you	to	open	a	previously-created	pipeline.	If	you	click	this		 button	when	
commands	are	already	in	the	middle	pane	of	the	pipeline	window,	you	will		 be	given	the	option	to	
replace	the	current	commands	or	append	the	pipeline	you	are		 opening	to	the	end	of	the	current	
commands.	

	 B.	“Save	Pipeline	As…”	allows	you	to	save	your	pipeline.	Pipelines	do	not	automatically		 save.	If	you	
clear	the	pipeline	or	replace	the	pipeline	by	opening	another	pipeline,	the		 pipeline	will	not	be	saved	
and	you	will	not	be	prompted	to	save	it.	

	 C.	“Clear	Pipeline”	clears	all	commands	from	the	middle	pane	of	the	pipeline	window.	
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	 D.	“Clear	Parameters”	will	clear	any	parameters	entered	in	pipeline	commands.	

	 E.	“Step”	will	execute	the	command	currently	highlighted	in	the	middle	pane.	

	 F.	“Execute	Pipeline”	will	execute	the	entirety	of	the	commands	in	the	middle	pane	of	the	
	 pipeline	window	from	the	first	command	to	the	last.	

	 G.	Note	that	there	is	no	“undo”	button	anywhere	in	V3D.	

7.	Key	pipeline	commands.	Users	can	follow	along	in	the	“R_LE_walk_pipeline”	for	examples	of	the	
implementation	of	each	of	these	commands.	

A.	Create_Hybrid_Model	+	Apply_Model_Template:	while	models	can	be	created	and	applied	using	
the	point	and	click	steps	detailed	above,	it	is	often	useful	to	automate	these	steps	once	a	model	has	
been	created	and	piloted.	The	“Create_Hybrid_Model”	command	will	prompt	a	user	to	open	a	
standing	calibration	trial	and	load	this	trial	into	the	V3D	workspace.	The	“Apply_Model_Template”	
command	will	prompt	the	user	to	select	a	model	(.mdh)	file	and	then	apply	this	model	to	the	
standing	calibration	trial.	

B.	File_Open:	this	command	prompts	the	user	to	open	files	which	will	be	loaded	into	the		 V3D	
workspace.	In	the	“R_LE_walk_pipeline,”	this	command	is	used	to	load	movement		 trials	after	
the	creation	of	the	model.	

C.	Assign_Model_File:	this	command	will	prompt	the	user	to	assign	the	model	file	to		 movement	
trials.	

D.	Lowpass_Filter:	target	(marker)	and	analog	data	often	need	to	be	filtered	to	remove		 noise.	There	
are	many	filter	options	in	V3D	pipelines	(see	the	“Signal	Filter”	section	in	the	left	hand	pane	of	the	
pipeline	window).	In	general,	raw	data	should	be	filtered	before		performing	calculations.	Which	
filters	should	be	used	and	at	what	step	of	the	analysis	they	should	be	implemented	depends	on	the	
task	being	performed	and	the	analysis	required.	In	the	“R_LE_walk_pipeline”	example,	a	lowpass	
Butterworth	filter	is	applied	to	the	marker	data	to	remove	signal	above	8	Hz.	The	“NUM_REFLECTED”	
line	in	the	command	provides	100	reflected	points	on	either	side	of	the	data	to	minimize	time	shifts	
in	the	data	due	to	the	filter.	Note	that	when	the	target	data	are	filtered,	the	filtered	data	are	placed	
in	a	new	folder:	TARGET	>	PROCESSED,	while	the	original,	unfiltered	data	remain	in	the	TARGET	>	
ORIGINAL	folder.	

E.	Interpolate:	this	command	will	fill	data	gaps	of	a	specified	size.	This	should	not	be		 used	in	lieu	
of	tracking	data	in	QTM	but	rather	as	a	final	sweep	to	correct	any	small	gaps		 that	were	missed	in	
tracking.	

F.	Select_Active_File:	this	command	can	be	used	to	select	all	files	or	groups	of	files	for		 further	
pipeline	commands.	When	paired	with	an	earlier	“Assign_Tags_To_Files,”	the		 Select_Active_File	
command	can	be	used	to	perform	pipeline	commands	on	only	a		subset	of	files.	

G.	Event	commands	(e.g.,	Event_Minimum,	Event_Maximum,	Event_Threshold):	can	be		used	to	
automatically	create	events	such	as	heel-strikes,	toe-offs,	maximum	flexion,	etc.		 These	
commands	can	be	found	in	the	“Event	Creation”	and	“Event	Management”		 sections	of	the	left	
hand	pane	of	the	pipeline	window.	Note	that	it	is	often	most	useful	to		 edit	these	commands	using	
the	“Text”	option	rather	than	the	default	GUI	window.	
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H.	For	loops:	the	“For_Each”	and	“End_For_Each”	commands	can	be	used	to	begin	and		 end	for	
loops.	In	the	“R_LE_walk_pipeline”	example,	these	are	used	to	recursively		 rename	gait	cycle	
events.	

	

I.	Signal	math	commands:	these	commands	can	be	used	to	perform	simple	arithmetic	on	signals.	For	
example,	in	the	“R_LE_walk_pipeline,”	the	number	of	frames	between	consecutive	heel	strikes	and	
between	heel	strikes	and	toe-offs	are	used	to	determine	gait	cycle	times	(using	Subtract_Signals)	and,	
subsequently,	the	percent	of	the	gait	cycle	spent	in	the	stance	phase	(using	Divid_Signals).	

J.	Metric	commands:	these	commands	create	new	signals	in	the	“METRIC”	folder.	

K.	Compute_Model_Based_Data:	this	command	is	perhaps	the	most	important	command	in	V3D	
pipelines.	With	it,	a	user	can	compute	a	huge	range	of	variables.	When	editing	this	command	the	
following	window	appears.	In	it,	you	name	the	data	variable	you	are	creating,	identify	what	type	of	
variable	you	are	calculating,	and	define	the	data	being		 used	to	calculate	this	new	variable.	There	are	
many	different	types	of	variables	that	can	be	created	and	the	specifics	of	the	algorithms	used	or	
computational	order	can	be	found	in	the	V3D	online	documentation.	The	“Use	Negative”	options	
allow	you	to	multiply	a	signal	by	-1	as	you	calculate	it,	which	is	commonly	used	to	align	data	
directions	with	common	reporting	practices	(e.g.,	the	right-hand	rule	will	generally	result	in	knee	
extension	being	a	positive	value,	while	reporting	practices	generally	follow	that	knee	flexion	should	
be	positive).	Cardan	Sequence	should	generally	follow	from	axis	of	largest	expected	excursion	to	axis	
of	smallest	expected	excursion	for	the	movement	of	interest.	In	the	below	example	window,	for	the	
right	hip	during	walking	we	would	expect	the	largest	excursion	to	be	in	the	sagittal,	or	X,	axis,	
followed	by	frontal	(Y	axis)	and	transverse	(Z)	motion.	

	

	

	

	

Data	variable	you’re	creating	
(must	type	in	name)	

What	type	of	variable	you’re	creating	

Definitions	for	variable	calculation	
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L.	Export_Data_To_Ascii_File:	this	command	is	used	to	export	data	to	a	tab-delimited	text	file	which	
can	be	read	in	excel	or	imported	into	a	further	data	analysis	program,	such	as	MatLab.	In	the	GUI	
window	which	pops	up	when	you	edit	this	command,	you	can	designate	the	path	for	your	exported	
Ascii	file,	select	options	such	as	exporting	the	mean	and	standard	deviation	of	your	data	(if	you	have	
multiple	trials),	normalize	your	data	(to		make	all	trials	the	same	relative	length),	among	other	
options.	When	you	select	the	signal	type,	folder,	name,	and	component	you’d	like	to	export,	you	
must	click	“Add	a	New	Signal”	to	save	these	selections	into	the	command.	Likewise,	if	you	wish	to	
edit	an		existing	command,	you	must	click	the	“Modify	Selected”	button	after	making	your	edits		to	
save	them.	In	the	example	from	“R_LE_walk_pipeline,”	note	that	each	stride	of	data	must	have	a	
separately	designated	event	sequence	and	thus	a	separate	line	in	the	GUI.	If	you	run	this	command	
(with	an	appropriately	renamed	file	name	path),	you	can	open	the	exported	file	in	excel	to	view	the	
format	of	V3D	Ascii	files.	If	“Export	Mean	and	Standard	Deviation”	is	selected,	the	mean	and	standard	
deviation	of	all	lines	in	the	GUI	will	be	computed,	and	these	will	appear	as	columns	2-7	in	the	Ascii	
export.	Note	that	if	you	re-run	the	“Export_Data_To_Ascii_File”	command	without	changing	the	
“Exported	Ascii	File”	name,	you	will	overwrite	any	existing	file	at	that	file	address.	V3D	will	not	give	a	
“are	you	sure	you	wish	to	overwrite…”	warning	dialog	before	overwriting	existing	data.	
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IV.	Reports	

V3D	can	create	reports	to	assist	with	data	visualization.	These	reports	can	plot	variables	that	have	been	
calculated	and	can	generally	be	useful	for	checking	calculations.	A	report	is	included	in	the	“Reports”	tab	of	
the	“R_LE_walk.cmo”	file	and	the	corresponding	report	template	file	is	included	in	demonstration	files	as	
“R_LE_report_template.rgt.”	This	report	consists	entirely	of	2D	graphs	of	joint	kinematics.	Reports	are	also	
able	to	generate	tables,	bar	graphs,	and	other	graphics.	Below	are	some	guidelines	for	creating	a	report.	

1.	When	creating	a	new	report	from	scratch,	first	designate	the	location	of	the	item	(graph/graphic)	you	wish	
to	add,	select	the	type	of	item	you	wish	to	add,	and	click	the	“Add”	button.	

	

	

Location	of	item	to	add	

Item	to	add	
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2.	An	“Add/Modify	Graph”	window	will	pop	up.	Here	you	can	designate	what	data	to	graph	in	which	position.	
Below	is	an	example	of	this	window	populated	for	plotting	one	stride	of	sagittal	hip	angle	data.	

	

	

3.	In	a	report	with	multiple	movement	cycles	and	multiples	variables	of	interest,	there	will	be	many	lines	in	
the	report	generation	dialog.	Along	with	multiple	columns	and	rows	of	plots	on	a	single	page,	reports	can	
contain	multiple	pages,	allowing	for	easy	visualization	of	lots	of	data.	If	you	are	interested	in	generating	
reports,	it	is	recommended	that	you	explore	the	documentation	on	reports	in	the	V3D	wiki	(https://www.c-
motion.com/v3dwiki/index.php/Tutorial:_Creating_a_Report)	for	further	information	and	examples.	
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UNIVERSITY	OF	MASSACHUSETTS	AMHERST	

INSTITUTE	FOR	APPLIED	LIFE	SCIENCE	

Human	Testing	Center	

	Human	Motion	Core	

Chapter	2:	Delsys	Trigno	EMG	

	

1. General	Information	about	Trigno	Sensors	
1.1. Sensors	1-8	have	EMG	+	Triaxial	Accelerometer	sensors.		

1.1.1. 	When	used	in	conjunction	with	QTM	the	sensors	have	collection	frequencies	of	EMG	
1925.25Hz	(upsampled	to	2000	Hz)	and	148.48	Hz	(upsampled	to	??).	

1.2. Sensors	9-16	have	EMG	+	Triaxial	Accelerometer,	Gyroscopes	and	Magnetometers.	
1.2.1. When	used	in	conjunction	with	QTM	the	sensors	have	collection	frequencies	of	EMG	1925.25Hz	

(upsampled	to	2000	Hz)	and	148.48	Hz	(up	sampled	to	??).	
	

	
2. Configuring	the	Trigno	Sensors	

2.1. Open	the	‘Delsys	Trigno	Contorl	Utility’		
2.2. In	the	lower	right	corner	of	the	screen	press	‘Configure’	

	
	
Add	the	rest	of	the	configuration	screens	–	what	they	are	how	they	work.	
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3. Pairing	Sensors.	
	

3.1. Pair	the	sensors	you	would	like	to	use	
3.1.1. Push	the	pair	button	in	“Delsys	Trigno	Control	Utility’	software.		

	
3.1.2. 	Push	the	button	on	the	sensor	until	you	see	a	flashing	green	light.	You	should	also	receive	a	

confirmation	on	the	computer	screen	that	the	sensor	has	successfully	paired	
	
	

4. Placement	and	orientation	of	sensors	
	
	
	
5. Enabling	Sensors	in	QTM	

5.1. Input	Device	

		
	

6. Labeling	Sensors	in	QTM	
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7. Accessing	Sensor	data	in	QTM	

7.1. Sensor	data	can	be	viewed	in	real	time	
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MANUAL	OF	PROCEDURES	
	

Living	Science	Core	
	
	

Institute	of	Applied	Life	Sciences	

Life	Science	Laboratories	S360	
240	Thatcher	Road,	

Amherst,	MA	01003	

at	the		

University	of	Massachusetts,	Amherst	
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UNIVERSITY	OF	MASSACHUSETTS	AMHERST	

INSTITUTE	FOR	APPLIED	LIFE	SCIENCE	

Human	Testing	Center	

	Living	Science	Core	

Chapter	1:	Oxycon	Mobile	

	

	

1.1 Introduction:	The	Oxycon	mobile	is	a	portable	indirect	calorimetry	unit	that	measures	metabolic	
responses	to	exercise,	work	or	other	activities	that	stationary	metabolic	units	cannot	measure.	The	
wireless	capabilities	of	this	unit	operate	via	telemetry,	up	to	1,000m	in	line	of	sight	range.	The	Oxycon	
Mobile	affords	users	the	opportunity	for	on-the-spot	recording	of	cardiopulmonary	and	deduced	
parameters	such	as:	VO2,	VCO2,	RER,	VEO2,	VECO2,	PETO2.	VE,	VT,	BF,	BR,	and	SpO2,	etc.	Researchers	can	
choose	to	monitor	parameters	in	either,	breath-by-breath	or	intrabreath	epochs.	Additionally,	
researchers	can	monitor	these	data	in	real-time	(via	telemetry),	or	post	hoc,	as	data	are	stored	to	an	
internal	SD	memory	card.		

	
Core	Competencies:	
	

1. Be	able	to	follow	calibration	instructions	
2. Understand	how	to	outfit	participant	with	equipotent	
3. Review	steps	for	setting	up,	collecting,	and	reviewing	session	data	through	a	screen	report	
4. Familiarize	yourself	with	how	to	generate	a	.CSV	report	

		
1.2 How	to	Calibrate:		Below	is	a	step-by-step	outline	for	calibrating	the	unit.		

Preliminary	Calibration	Steps	
1.) Retrieve	Computer	from	Oxycon	case	

a. Username:	labsup			 Password:	lab	
2.) Collect	receiver	unit	(pictured	below)	
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3.) Plug	in	power	and	connect	computer	to	receiver	unit	using	grey	USB	cable	
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4.) Grab	the	two	packs	(SBX,	DEX)	and	a	memory	card	
a. SBX:	Sensor	box	(O2	&	CO2	sensor)	
b. DEX:	Data	exchange	unit	

	
	
	
	
	
	
	

Power	cord	
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5.) Warm	up	SBX	by	connecting	it	to	the	receiver	with	yellow	Ethernet	cable	

	
	

	
6.) Open	lab	manager	

a. Allow	warm-up	for	15	minutes	
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7.) Assemble	necessary	components	of	mask	
a. Attach	turbine	to	turbine	holder	(metal	(silver)	side	in	first)	

	
b. Make	sure	turbine	is	not	wet	
c. Connect	infrared	sensor	to	turbine	

	
d. Be	sure	sampling	tube	is	attached	to	the	turbine	holder	(opposite	end	of	infrared)	
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8.) Attach	mask	components	and	tighten	sampling	tube	and	infrared	sensor	to	SBX	
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9.) Place	appropriate	study	memory	card	in	DEX	unit	and	add	battery	(make	sure	it	is	charged)	

	
a. If	DEX	doesn’t	turn	off	right	away,	press	off	button	

	
10.) After	15	minutes,	lab	manager	should	open	up	to	a	home	screen	
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11.) Connect	SBX	to	DEX	using	yellow	Ethernet	cable	

	
a. After	a	few	seconds	of	SBX	vibrating,	a	light	should	flash	on	SBX	
b. If	the	battery	is	low,	SBX	will	beep	and	a	note	will	pop	up	on	the	screen	
c. Be	sure	green	LED’s	on	both	units	are	lit	prior	to	calibration	

	
	
	
	
	
	
1.3	Oxycon	Mobile	Calibration	

1. Click	Ambient	conditions	on	the	lab	manager	
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a. DEX	senses	
i. Usually	accurate	temperature	and	barometric	pressure	
ii. Manually	enter	humidity	

b. Check	grey	box	in	the	laboratory	on	the	Parvo	metabolic	cart	for	environmental	
conditions	

i. Press	F1	to	change	temperature,	barometric	pressure	and	humidity	
ii. Leave	barometric	pressure	as	is	

c. Press	F12	to	save	
	
	
	

2. Connect	SBX	back	to	receiver	using	yellow	Ethernet	cable	
a. Wait	for	SBX	to	get	power	(will	vibrate	and	LED	lights	up	green	when	ready	to	continue)	

	
3. Set	up	for	AutoVolume	Calibration	

a. Click	Auto	volume	calibrations	from	calibrations	group	
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b. Wait	for	graph	to	come	up	

	
	

	
	

4. Connect	white	sampling	tube,	into	receiver	and	SBX	
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5. Connect	mouthpiece	with	turbine	into	PCA	(black	hole)	with	sample	tube	hole	covered	

	
	
	
	
	
	
	
	
	

	
6. Press	F1	to	begin	AutoVolume	Calibration	
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a. If	%difference	is	less	than	3%	press	F12	to	save	
b. If	%difference	is	greater	than	3%,	check	lines	and	connections	and	retry	

	
7. Gas	Analyzer	Calibration	

a. Connect	gas	cylinder	into	unit,	push	clip	until	it	is	locked	
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b. Open	gas	cylinder	by	twisting	the	valve	from	the	calibration	gas	two	complete	turns	

	
	

i. Cylinder	contains	15.98%	O2	and	3.9%	CO2	concentrations	
	

c. Click	on	Gas	Analyzer	Calibration	in	the	lab	manager	
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d. Click	on	the	settings	tab	at	the	top	and	enter	in	analysis	results	from	the	“Certificate	of	
Analysis”	provided	by	Airgas,	this	sheet	should	be	with	the	gas	tanks	

e. Then,	press	F1	to	begin,	Graph	will	appear	and	calibration	will	begin	
f. Calibration	will	sample	room	air	along	with	cylinder	air	

	

	
g. O2	peaks	at	21	and	valley;	blue	line	
h. CO2	will	valley	at	0	and	then	peak;	red	line	
i. If	percent	difference	less	than	3%	press	F12	and	save	
j. Turn	of	air	cylinder	
k. If	percent	error	greater	than	3%,	repeat	process	

	
	

8. Reassemble	SBX	and	DEX	with	yellow	Ethernet	
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9. Reassemble	mouthpiece	with	sampling	tube	
a. Place	new	battery	in	DEX	
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1.4	Testing	with	the	Oxycon	Mobile	

1. Input	patient	data	
a. Press	F2	to	create	new	subject	
b. Be	sure	to	fill	out	Last	Name,	First	Name,	Identification,	DOB,	Gender,	Height	and	Weight	

(press	enter	to	navigate	through	patient	inputs)	

	

c. Press	F12	to	save	current	subject	information	

2. Size	subject	for	heart	rate	belt	
a. Wet	sensors	
b. Attach	sensors	to	belt	
c. Subject	puts	on	heart	rate	monitor	ensuring	the	sensor	is	at	the	sternum	

	
3. Size	subject	for	mask	

a. Have	subject	put	mask	on	and	cover	breathing	hole	
b. Have	the	subject	blow	to	make	sure	there	are	no	leaks	
c. Attach	the	four	clips	to	the	mask	
d. Have	the	subject	hold	the	mask	in	place	while	the	researcher	clips	the	black	head	gear	

net	to	the	mask	(tag	goes	in	front)	
	

4. Size	subject	for	backpack	
a. Attach	the	SBX	and	DEX	to	the	backpack	(wires	facing	up)	
b. Subject	puts	on	backpack	
c. Attach	mask	with	white	sampling	tube	(white	sampling	tube	should	be	closest	to	the	

subjects	face)	
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5. To	begin	data	collection,	click	breath	by	breath	
	

	
a. Make	sure	DEX	and	SBX	have	green	lights	

i. If	yellow,	flip	SBX	and	DEX,	check	HR	belt	position,	check	battery	
	

6. Ensure	all	Patient	Data	is	correct	
	
	

7. Check	Test	settings	
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a. Ergometer-	Modality	must	be	bicycle	
b. Dead	Space-	click	appropriate	size	corresponding	to	subject’s	mask	size	
c. Averaging-	Method,	Breaths	

	
	

8. Press	F1	or	play	to	analyze	baseline	information	(background	zeroing,	noted	in	bottom	right	
corner)	

9. Press	F1	or	play	again	to	start	recording	data	
10. After	data	collection	is	complete	be	sure	the	upper	left	button	(play)	is	now	a	“stop”	button	to	

end	recording	
11. Press	12	to	exit	and	save	

	
1.5	Reviewing	the	Data		

1. Click	on	Screen	Report	to	view	collected	data	

	
2. From	the	report	list,	choose	the	report	view	you	would	like	(study	specific,	for	more	information	on	

creating	new	data	visualization	templates	see	below)	
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3. Press	OK	to	generate	the	report	

	
	

4. To	export	usable	data	press	F9	and	save	on	a	local	drive	
	
	
	
	
	
	

5. To	import	from	storage	device	select	Flashdisk	reader	
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6. Import	the	file	you	would	like	to	review	
7. Make	sure	the	Current	patient	matches	the	file	you	are	trying	to	import	
8. Press	F1	to	read	file	
9. After	file	is	loaded	press	F12	to	save	
10. Repeat	Steps	1-4	
11. To	view	saved	file	in	Excel,	open	Excel	and	go	to	File-Open	
12. Find	the	saved	file		
13. When	prompted	by	the	Import	Wizard,	Make	sure	Import	Row	is	at	1	and	Fixed	Width	is	selected	

	
	

14. Click	Next	
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15. When	prompted	with	text	import,	also	click	next	

	
	

16. On	the	final	step,	Click	advanced	and	make	sure	separators	are	correct	

	
	

	
	
	
	
	

17. After	import	is	complete,	select	Save	as	and	be	sure	to	check	the	correct	file	extension	
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1.6	Cleaning	Equipment	
1. Disassemble	all	pieces	to	be	cleaned	
2. Wipe	turbine	holder	and	infrared	sensor	with	alcohol	wipes.	
3. Headgear	straps	and	heart	rate	monitors	should	be	rinsed	and	hung	up	to	dry	
4. Masks	should	be	soaked	in	a	25:1	cleaning	solution	for	30	seconds	and	rinsed	thoroughly	
5. The	turbine	must	be	soaked	in	a	special	solution	

a. In	the	marked	container,	fill	the	to	the	brim	with	Sterilizing	and	Disinfecting	solution	
b. In	the	clear	plastic	cup	located	nearby,	fill	the	cup	to	the	first	indent	(black	line)	with	the	

Activator	solution	
c. Pour	the	Activator	solution	in	the	sterilizing	solution	and	mix	thoroughly	
d. Place	the	plastic	grate	into	the	solution	with	the	turbine	inside	
e. Allow	the	turbine	to	sit	for	15	minutes		
f. Remove	from	solution	and	rinse	with	water		
g. Let	air	dry	

	
1.7	Creating	a	New	Data	Visualization	Template		
1. Click	on	the	utilities	tab	
2. Enter	password:	abcd	
3. Click	on	report	designer	
4. Name	new	report,	output	unit:	default	printer	(JLAB	pdf	printer)	
5. Click	ok	
6. Click	on	the	table	at	the	right	(has	F3	on	button)	

Comment	[MB3]:	Is	this	actually	the	password?		
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7. Choose	Oxycon	table,	then	click	summary		
8. Here	you	can	choose	measurement	program	(breath-by-breath,	endtidal,	cardiac	output,	intrabreath,		

etc.)	
9. Depending	on	the	measurement	program	selected	you	can	add	parameters	to	your	summary,	do	this	

by	highlighting	a	parameter	you	are	interested	in	and	click	“Insert”.	This	will	add	it	to	your	screen	
report	summary	

10. By	further	navigating	through	the	tabs	at	the	top	of	the	dialogue	box,	you	can	select	averaging	type	
(intervals),	layout,	marker,	and	setup	settings	

	
11. Press	F12	to	save	the	report,	and	name	the	report.	Note:	the	name	you	give	the	report	will	be	how	it	

is	presented	in	the	screen	report	section	(see	Reviewing	the	Data	to	re-familiarize	yourself	with	this	
step)	
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1.8	Contacts		
	

1. Kim	at	Carefusion:	1	800	231	2466		
Operator	will	prompt	you	through	a	screener,	click	1	at	first	question,	click	2	at	second	question,	click	
3	at	third	question.	

	
Note:	Have	receiver	unit	on	hand	when	you	call,	it	has	serial	number	they	will	need	when	assisting	you.		
	

2. Michael	Busa	–	Core	Director	
413-577-0574	

	 mbusa@umass.edu	
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UNIVERSITY	OF	MASSACHUSETTS	AMHERST	

INSTITUTE	FOR	APPLIED	LIFE	SCIENCE	

Human	Testing	Center	

	Living	Science	Core	

Chapter	2:	Actigraph	Link	(GT9X)	

	

2.1	Supplies	

1) ActiGraph	GTX	accelerometer	charging	cable	
2) ActiGraph	dock	
3) ActiLife	6	software	
4) Computer	to	run	ActiLife	6	software	

	
2.2	Device	Charging	

The	ActiGraph	GT9X	accelerometer	contains	a	rechargeable	Lithium	Polymer	battery	which	is	
capable	of	providing	power	for	continuous	data	collection	periods	of	10	or	more	days	without	
recharging.	If	the	battery	has	been	fully	depleted	at	the	time	of	charging,	it	will	take	
approximately	3-4	hours	for	the	ActiGraph	GT9X	accelerometer	to	reach	full	charge.	
Charging	Procedures	

1) Connect	ActiGraph	dock	to	computer	or	wall	outlet	using	mini	USB	cable	
2) Plug	the	ActiGraph	Link	into	the	dock	with	the	ActiGraph	logo	facing	up.		Once	

connected,	the	red	LED	light	on	the	right	side	of	the	dock	will	turn	yellow,	the	device	
screen	will	display	the	serial	number,	and	the	batter	icon	will	blink	to	indicate	charging.	

3) Once	the	device	is	fully	charged,	the	yellow	light	will	turn	green	and	the	battery	icon	on	
the	device	will	show	as	full	and	stay	on	steady	

2.3	Device	Initialization	
The	ActiGraph	GT9X	accelerometers	are	initialized	with	the	ActiLife	6	software	package.	The	
ActiGraph	GT9X	accelerometer	will	not	collect	data	unless	it	is	initialized	using	the	ActiLife	
software.		
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Initialization	Procedures	

1) Open	the	ActiLife	6	software	by	double-clicking	on	the	desktop	icon	or	by	single-clicking	
on	the	start	menu	shortcut	for	the	program.	

	
2) Plug	the	charging	cable	into	a	standard	USB	port	on	the	computer	running	the	ActiLife	6	

software.		
3) Select	the	accelerometer	that	will	be	initialized	by	checking	the	box	beside	the	

accelerometer	device	name	and	serial	number.	

	
	
4) From	the	“Initialize”	button	choose	“Regular	Initialization”.	This	will	open	the	primary	

initialization	window.	

1) 

3) 
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5) Select	a	sampling	rate		
6) Select	idle	sleep	mode.	
7) Note:	Select	Wireless	Option,	heart	rate,	sleep	mode,	and	IMU	
8) Click	the	“Enter	Subject	Info”	button.	This	will	open	the	secondary	initialization	window.	

	
	
	
	
	
	
	

6) 

7) 

8) 

4) 

5) 
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9) Select	a	start	date	and	time	at	the	time	subject	orientation	is	scheduled	to	begin	
10) Select	a	stop	date	and	time	to	stop	data	collection	at	a	specified	time	(can	be	left	blank)	

	
	

11) 	Input	an	appropriate	identifier	(e.g.,	“S#”)	in	the	“Subject	Name”	field.	
12) Input	the	appropriate	“Limb”	and	“Side”	information	(e.g.	right	hip	or	left	wrist)		
13) Click	the	“Initialize	1	Device”	button.	This	will	close	the	window	and	return	to	the	main	

software	window.	
14) 	If	properly	initialized,	the	words	“finished	initializing”	should	appear	underneath	the	

“Status”	column.	

	
	

15) The	ActiGraph	GT9X	accelerometer	is	now	ready	for	data	collection.	Unplug	
accelerometer	from	the	charging	cable.	
	

	

	

	

	

	

	

9) 

11) 

12) 

13) 
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2.4	Accelerometer	Placement	

The	ActiGraph	GT9X	can	be	worn	at	the	hip	(around	the	waist)	and	on	the	wrist.	Elastic	belts	
and	wrist	straps	will	be	used	to	secure	the	accelerometers	to	the	participant’s	body	(see	
pictures	for	details).		

	

Secured	around	the	waist	at	the	right	hip	and	attached	to	an	elastic	belt.	Make	sure	that	the	GT9X	is	
positioned	directly	on	the	
body’s	side	(mid-axillary	
line)		

	

	

2.5	Data	Retrieval	and	Download	

The	previously	described	ActiLife	6	software	utility	is	required	to	download	data	from	the	
ActiGraph	GT9X	accelerometer.	
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Download	Procedures	
1) Open	the	ActiLife	6	software	by	double-clicking	on	the	desktop	icon	or	by	single-clicking	on	the	start	

menu	shortcut	for	the	program.	

	
	

2) 	Plug	the	ActiGraph	Link	into	the	dock	with	the	ActiGraph	gold	plates	contacting	the	gold	pins	of	the	dock.	
3) Plug	the	charging	cable	into	a	standard	USB	port	on	the	computer	running	the	ActiLife	6	software.	
4) Select	the	accelerometer	that	will	be	initialized	by	checking	the	box	beside	the	accelerometer	device	

name	and	serial	number.	

	
	

5) Click	on	the	“Download”	button.	This	will	open	the	primary	download	window.	
Click	“Change	Location”	to	select	destination	file		

6) Within	the	“GT9X	Download	Options”	box,	make	sure	the	“Create	AGD	File”	box	is	checked	and	specify	
the	“Epoch”.	

7) Check	the	appropriate	boxes	for	your	protocol.	

1) 

4) 

5) 
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8) 	Click	the	“Download	All	Devices”	button.	The	primary	download	window	will	close	and	return	to	the	main	

software	window	and	dialog	box	will	appear	asking	you	to	name	the	file.	The	download	process	may	take	
several	minutes.	

	
	

5) 

5)) 

8) 

7) 

6) 

9) 
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9) 	If	properly	data	was	properly	downloaded,	the	words	“finished	downloading”	should	appear	underneath	

the	“Status”	column.	 	

10) Now	it	is	necessary	to	process	the	default	filter	.agd	file.	Select	“Scoring”	>	Check	all	item	>	click	“Remove	
Selected”	>	Click	“Add	Dataset”	>	Select	the	previously	downloaded	AGD	File	

11) Click	“Calculate”	
12) Go	to	“Details”	on	the	calculated	file	and	click	“Export	All	Epochs”	
13) Go	to	“Open	Containing	Folder”,	rename	the	file	(S#_ActiGraph_Location.csv)	and	put	it	in	the	

appropriate	folder	

	

	
	

10) 



Updated:	16	October	2017	 Room	Calorimeter	Core	 	1	

	

MANUAL	OF	PROCEDURES	
	

Room	Calorimeter	Core	
	
	

Institute	of	Applied	Life	Sciences	

Life	Science	Laboratories	S360	
240	Thatcher	Road,	

Amherst,	MA	01003	

at	the		

University	of	Massachusetts,	Amherst	

	
	

	
	
	

	
	 	



Updated:	16	October	2017	 Room	Calorimeter	Core	 2	

UNIVERSITY	OF	MASSACHUSETTS	AMHERST	

INSTITUTE	FOR	APPLIED	LIFE	SCIENCE	

Human	Testing	Center	

Room	Calorimeter	Core	

Chapter	1:	Quick	Guide	for	Calibration/Validation	

	

Supplies	

	

Quick	Guide:	Calorimeter	Room	Operation	

	

Gas	Tank	Check	List		
Prior	to	calibration	tests	and	validation	studies,	check	tank	pressures.		

Tank	 Minimum	Pressure	 Tests	

CO2	 100	psi	 Infusion,	Short	Circuit,	
Blender	Calibration	

O2	 800	psi	for	blender	cal,	NA	
for	infusion	

Blender	calibration	

Start	CalRQ	 Login	

Select	
Mode	

Human	or	Validation	
Study	 Calibration	

Cal	
Check	

Complet

Null	Test	

No	

Yes	

Run	Study	 Null	Test	

Figure 1. Study Setup Flow 
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N2	 1500	for	blender	cal,	800	psi	
for	Infusion,	500	for	Short	
Circuit	

Infusion,	Short	Circuit,	
Blender	Calibration	

Zero	Tank	 400	psi	 Tank	Calibration,	Cal	Check	

Span	Tank	 400	psi	 Tank	Calibration,	Cal	Check	

Ref	Tank	 400	psi	 All	tests	–	always	open	

	

	

	

	

	

Panel	instrument	settings	for	all	tests	
	 	 Std	Setting	

1	 Chamber	1	O2	Rotameter	 1.25	L/min	

2	 Chamber	1	CO2	Rotameter	 1.25	L/min	

3	 Chamber	2	O2	Rotameter	 1.25	L/min	

4	 Chamber	2	CO2	Rotameter	 1.25	L/min	

5	 Inflow	O2	Rotameter	 1.25	L/min	

6	 Inflow	CO2	Rotameter	 1.25	L/min	

7	 Chamber	1	Sample	Pressure	Gauge		 2	psi	

8	 Chamber	1	Sample	Pressure	Regulator	 2	psi	

9	 Chamber	2	Sample	Pressure	Gauge		 2	psi	

10	 Chamber	2	Sample	Pressure	Regulator	 2	psi	

11	 Inflow	Sample	Pressure	Gauge		 2	psi	

12	 Inflow	Sample	Pressure	Regulator	 2	psi	
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Analyzer	Calibration	

	

Cal	Check:	flow	zero	and	span	gases	to	check	values	

Analyzer	Gain:	Subtract	the	apparent	concentration	on	the	computer	of	the	span	value	from	the	
apparent	concentration	on	the	computer	of	the	zero	value.	This	delta	should	match	the	delta	of	the	
span	from	the	blender	or	tanks	(Span	(20.95)	–	Zero	(20.05)	=	0.9	delta).			

Analyzer	Calibration:	Flow	zero	and	span	gases,	change	slope	and	offset	values	in	the	analyzer.	If	
analyzer	values	are	out	of	range	(<19.8%	or	>21.2%	for	O2;	>1.1%	for	CO2)	perform	calibration	on	
analyzers,	when	analyzers	are	stable,	perform	calibration	on	software,	if	needed.		

Software	Calibration:	Flow	zero	and	span	gases,	change	slope	and	offset	values	in	the	software	

Delta:	The	difference	between	the	span	value	and	the	zero	value.	Subtract	the	apparent	
concentration	of	the	span	value	displayed	on	the	computer	from	the	apparent	concentration	on	the	
computer	of	the	zero	value.	

𝐷𝑒𝑙𝑡𝑎	 = 𝑧𝑒𝑟𝑜 − 𝑠𝑝𝑎𝑛	 	 	 	 	 eq	(1)	
0.9 = 20.95 − 20.05	 	 	 	 	 eq	(2)	

Data	file	is	recording	when	the	logging	button	(J)	displays	“Logging	On”	and	Enter	Note	box	(K)	
appears.	File	recording	will	stop	when	logging	button	displays	“Logging	Off”	or	“Done”	(L)	is	pressed.		
“Done”	also	closes	the	window.		

A	

B	

C	

E	
D	

C	

E	
D	

F	

I	
H	
G	

K	
J	

L	
Figure	2.	Calibration	Screen	
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Blender	Calibration:	

1. Open	N2,	CO2	and	O2	tanks	
2. Flip	Instrumentation	Panel	valves	to	match	those	shown	in	Figure	3.	Flip	blender	valves	for	

calibration.		
3. Check	flow	rates	(1.25	lpm)	and	pressures	(~2	psi)	for	each	analyzer	
4. Once	the	gas	is	flowing,	watch	the	O2	(A)	and	CO2	(B)	graphs	until	the	values	are	steady.	Turn	

Averaging	on,	and	let	blender	run	for	at	least	an	hour.		
5. After	hour	is	complete,	press	the	“Set	Zero”	button	(D).		
6. After	the	values	are	stored,	enter	the	calibration	tank’s	gas	concentrations	in	their	respective	

entry	boxes	in	the	“Cal	Gas”	column	(C)	(i.e.	if	a	calibration	gas	consisting	of	a	blend	of	
21.02	%O2	and	0	%CO2	is	flowing	into	the	analyzers,	21.02	would	be	entered	in	the	“Cal	Gas”	
column	for	the	O2	analyzers	and	0	would	be	entered	for	the	CO2	analyzers).	Default	tank	
values	can	be	changed	on	the	Preferences	screen.	

7. 	Repeat	steps	3-6	using	the	Span	Blend.		
8. Select	radio	buttons	(F)	for	each	analyzer	you	would	like	to	calibrate.	Buttons	will	turn	blue	if	

calculations	will	be	performed	for	that	analyzer.	
9. After	zero	and	span	values	have	been	stored,	press	“Calculate”	(G).	New	slopes	and	offsets	

are	calculated,	but	not	applied	to	analyzer	gas	values.		
10. If	slopes	and	offsets	are	acceptable,	press	“Apply”	(H).	New	slopes	and	offsets	are	saved	to	

the	configuration	file.		
11. Record	the	new	slope	and	offset	values	in	lab	notebook.	
12. Flow	Zero	gas	blend	through	the	analyzers	to	confirm	the	calibration	values.	Repeat	with	the	

Span	gas	blend.	If	either	blend	does	not	match	the	set	values,	repeat	the	calibration.	

	
Figure	3.	Panel	Layout	for	Blender	Calibration	

Comment	[MB4]:	What	are	acceptable	values?	
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Gas	Tank	Calibration	
	

1. Open		zero	and	span	tanks			
2. Flip	valves	as	those	shown	in	Figure	4	
3. Check	flow	rates	(1.25	lpm)	and	pressures	(~2	psi)	for	each	analyzer	
4. Once	the	gas	is	flowing,	watch	the	O2	(A)	and	CO2	(B)	graphs	until	the	values	are	steady.	Once	

steady,	press	the	“Set	Zero”	button	(D).		
5. After	the	values	are	stored,	enter	the	calibration	tank’s	gas	concentrations	in	their	respective	

entry	boxes	in	the	“Cal	Gas”	column	(C)	(i.e.	if	a	calibration	gas	consisting	of	a	blend	of	
21.02	%O2	and	0	%CO2	is	flowing	into	the	analyzers,	21.02	would	be	entered	in	the	“Cal	Gas”	
column	for	the	O2	analyzers	and	0	would	be	entered	for	the	CO2	analyzers).	Default	tank	
values	can	be	changed	on	the	Preferences	screen.	

6. 	Repeat	steps	3-6	using	the	Span	Calibration	Gas.		
7. Select	radio	buttons	(F)	for	each	analyzer	you	would	like	to	calibrate.	Buttons	will	turn	blue	if	

calculations	will	be	performed	for	that	analyzer.	
8. After	zero	and	span	values	have	been	stored,	press	“Calculate”	(G).	New	slopes	and	offsets	

are	calculated,	but	not	applied	to	analyzer	gas	values.		
9. If	slopes	and	offsets	are	acceptable,	press	“Apply”	(H).	New	slopes	and	offsets	are	saved	to	

the	configuration	file.		
10. Record	the	new	slope	and	offset	values	in	lab	notebook.	
11. Flow	Zero	gas	blend	through	the	analyzers	to	confirm	the	calibration	values.	Repeat	with	the	

Span	gas	blend.	If	either	blend	does	not	match	the	set	values,	repeat	the	calibration.		
	

	

Figure	4.	Panel	layout	for	Span	Gas	Calibration	(flip	the	highlighted	Calibration	Source	valve	from	
Span	Gas	to	Zero	Gas	for	span	calibration)	
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Tank	Cal	Check	
	

Purpose:	Check	analyzer	calibration	values	before	a	study	(human	and	validation).		

1. Open	Zero	and	Span	calibration	tanks	
2. Set	panel	up	as	shown	in	Figure	4.		
3. Flow	zero	gas	to	the	analyzers	by	turning	the	“Calibration	Source”	valve	to	“Zero	Gas”.	
4. Check	flow	rates	(1.25	lpm)	and	pressures	(~2	psi)	for	each	analyzer	
5. Once	the	gas	is	flowing,	watch	the	O2	(A)	and	CO2	(B)	graphs	until	the	values	are	steady.	Once	

steady,	record	the	zero	value.		
6. Repeat	steps	3-4	using	the	span	gas.			
7. Calculate	the	gas	delta	by	subtracting	the	zero	gas	measured	on	the	analyzer	from	the	span	

value	measured	on	the	value.	
8. 	

𝐷𝑒𝑙𝑡𝑎	 = 𝑍𝑒𝑟𝑜	𝑇𝑎𝑛𝑘	𝐺𝑎𝑠	𝑃𝑒𝑟𝑐𝑒𝑛𝑡𝑎𝑔𝑒 − 𝑆𝑝𝑎𝑛	𝑇𝑎𝑛𝑘	𝐺𝑎𝑠	𝑃𝑒𝑟𝑐𝑒𝑛𝑡𝑎𝑔𝑒	 	 	
ex.	O2:			0.9 = 20.95 − 20.05	
ex.	CO2:	0.99 = 0 − 0.99	

9. Verify	the	delta	is	within	+/-3%	of	the	expected	delta.		
10. If	delta	is	not	within	+/-3%	of	the	expected	delta,	perform	a	Tank	software	calibration.		

	
Table	1.	Delta	Example	

Expected	
Delta	

Allowable	
Difference	

0.9	 0.027	
1	 0.03	
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Null	Test	
	

A	null	test	verifies	the	offset	of	the	gas	analyzers.	The	test	is	performed	by	flowing	the	inflow	air	
(med	air)	to	both	the	inflow	and	outflow	analyzers.	An	offset	correction	is	made	on	the	Calibrate	
Analyzers	screen	in	CalRQ	TM	or	can	be	made	during	post	processing.			

1. Open	a	file	to	log	data	(Human	Study,	Validation	Study,	or	Calibration)	
2. Turn	the	Sample	Source	Valve	to	Null	(Figure	5).		
3. Let	the	system	run	until	the	humidity	reading,	plus	VO2	and	VCO2	on	the	software	stabilize.	This	

indicates	that	the	dryers	are	conditioned.	
4. Once	the	readings	are	stable,	record	the	null	data	for	at	least	10	min.	
5. 	If	applying	the	null	correction	in	real	time,	calculate	offset	correction	by	subtracting	Inflow	O2	

concentration	from	Outflow	O2	concentration.	Repeat	for	CO2.	Apply	offset	correction	to	the	
inflow	analyzer	offset	for	both	O2	and	CO2.	
		

	
Figure	5.	Panel	layout	for	null	test	
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Validation	Testing	
Short	Circuit		

	

Figure	6.	Short	Circuit	(SC)	Rack	Panel	Configuration.	Red	boxes	highlight	the	valves	that	must	be	
turned	for	the	correct	gas	stream	to	reach	the	analyzers.	**Shaded	red	box	highlights	the	valve	that	
determines	where	the	SC	infusion	is	sent.	Turn	the	valve	to	select	the	desired	chamber**	
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Figure	7.	Short	Circuit	MFC	Panel	Configuration	

1. Set	up	rack	panel	as	shown	in	Figure	4.		
Change	MFC	panel	as	shown	in	Figure	7	

2. Figure	9.	
3. Start	a	Validation	Study	(File	->	New	Validation	Study)	
4. Choose	Infusion	Radio	Button	
5. Enter	Validation	ID	–	Filename	will	be	Validation	ID	–	Chamber	#	-	Infusion-Date	
6. Set	desired	Inflow	and	Outflow	rates	(Edit	->Manual	MFC	Set)	

a. Inflow	Rate	=	60	lpm	
b. Outflow	Rate	=	0	lpm	
c. Use	the	high	flow	MFC	for	chamber	2.	Set	to	60	lpm	

7. Enter	flow	rate	in	Inflow	Setting	press	“Apply	Inflow”.	Check	Current	Inflow	Rate	is	as	
expected.		
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8. Run	a	null	–	same	gas	should	be	going	to	both	the	inflow	and	outflow	analyzers	(Valves	on	
the	panel	should	be	pointing	to	null)	

9. Check	flow	rates	(1.25	lpm)	and	pressures	(~2	psi)	for	each	analyzer	
10. Set	chamber	volume	to	0	on	the	Preferences	Screen.	
11. Open	Blender	Screen	(Edit	->	Adjust	Blender).	Choose	Flow	Rate	radio	button	
12. Select	Appropriate	MFC	and	set	flow	rate	or	select	desired	profile.	Press	“Apply”	to	start	flow	

through	blender.		
13. Flow	each	N2/CO2	blend	for	at	least	10	min	after	VO2	and	VCO2	have	stabilized		

a. Quick	check:	VCO2	should	be	close	to	CO2	flow	rate;	VO2	should	be	close	to		

(N2	flow	+	CO2	flow)*[O2	inflow]	
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Infusion	

	

Figure	8.	Infusion	Panel	Configuration	-	Red	boxes	highlight	the	valves	that	must	be	turned	for	the	
correct	gas	stream	to	reach	the	analyzers.	**Shaded	red	box	highlights	the	valve	that	determines	
where	the	infusion	is	sent.	Turn	the	valve	to	select	the	desired	chamber**	
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Figure	9.	Chamber	Study	MFC	Panel	Setup	

1. Set	up	Rack	panel	as	shown	in	Figure	6.	Select	the	correct	chamber	to	send	gas	infusion.		
Change	MFC	panel	as	shown	in		

2. Figure	9	
3. Start	a	Validation	Study	(File	->	New	Validation	Study)	
4. Choose	Infusion	Radio	Button	
5. Enter	Validation	ID	–	Filename	will	be	Validation	ID	–	Chamber	#	-	Infusion-Date	
6. Set	desired	Inflow	and	Outflow	rates	(Edit	->Manual	MFC	Set)	

a. Inflow	Rate	=	60	lpm	
b. Outflow	Rate	=	0	lpm	
c. Use	the	high	flow	MFC	for	chamber	2.	Set	to	60	lpm	

7. Enter	flow	rate	in	Inflow	Setting	press	“Apply	Inflow”.	Check	Current	Inflow	Rate	is	as	
expected.		
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8. Run	a	null	(~15	mins)	–	same	gas	should	be	going	to	both	the	inflow	and	outflow	analyzers	
(Valves	on	the	panel	should	be	pointing	to	null)	

9. Check	flow	rates	(1.25	lpm)	and	pressures	(~2	psi)	for	each	analyzer	
10. Set	Chamber	Volume	to	appropriate	volume	(Chambers	=	32500	liters,	Flex	=	5000	liters)	
11. Close	chamber	door.		
12. Add	a	note	to	data	file	with	chamber	set	up	(what	furniture	is	the	room,	platform,	bike	or	

empty	in	the	small	room)	
13. Switch	null	valve	to	Study.	Let	run	for	about	15	minutes	
14. Open	Blender	Screen	(Edit	->	Adjust	Blender).	Choose	Flow	Rate	radio	button	
15. Select	Appropriate	MFC	and	set	flow	rate	or	select	desired	profile.	Press	“Apply”	to	start	flow	

through	blender.		
16. Set	flow	rates	and	select	“Apply”	
17. Verify	Outflow	O2	and	Outflow	CO2	values	are	changing	as	expected.		

	
	

	

	

	

	


